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Safety notes
If the wheel transducer assembly is not securely fitted, it may become detached 
from the wheel and cause accident or injury.

On some vehicles, the wheel transducer may project beyond the bodywork of the 
vehicle and be considered a hazard to pedestrians or other road users. In this 
event, a curved protective cover should be fitted.

Operating the Hindsite software whilst driving the vehicle is hazardous and 
should be avoided.
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Purpose and scope
The purpose of this guide is to help you successfully use the Hindsite features 
and capabilities. This guide includes task-based instructions that describe how 
to install, configure, use, and troubleshoot the Hindsite. Additionally, this guide 
provides a description of Willtek’s warranty, services, and repair information.

Assumptions
This guide is intended for novice and intermediate users who want to use 
Hindsite effectively and efficiently. We are assuming that you have basic 
computer, Microsoft Windows and mouse experience and are familiar with basic 
telecommunication concepts and terminology.

Related information
Use this guide in conjunction with the following information:

– Willtek 8300 Griffin user’s guide if you are using Hindsite in conjunction 
with the Willtek 8300 Griffin Fast Measurement Receiver Series

– Willtek 8100 GPR user’s guide if you are using Hindsite in conjunction with 
the Willtek 8100 GPR General Purpose Receiver Series

Technical assistance 
If you need assistance or have questions related to the use of this product, call 
one of Willtek’s technical assistance centers. You can also contact Willtek by 
e-mail at customer.support@willtek.com.

Table 1 Technical assistance centers

Region Phone number Fax number

UK +44 (0) 20 8408 5720 +44 (0) 20 8397 6286

Europe, Middle East, 
Asia, Africa

+49 (0) 89 996 41 386
+49 (0) 89 996 41 227

+49 (0) 89 996 41 440

Americas +1 317 595 2021
+1 866 WILLTEK

+1 317 595 2023
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Conventions
This guide uses naming conventions and symbols, as described in the following 
tables.

Table 2 Typographical conventions

Description Example

User interface actions appear in this 
typeface.

On the Status bar, click Start.

Buttons or switches that you press 
on a unit appear in this TYPEFACE.

Press the ON switch.

Code and output messages appear 
in this typeface.

All results okay

Text you must type exactly as 
shown appears in this typeface.

Type: a:\set.exe in the dialog 
box.

Variables appear in this <typeface>. Type the new <hostname>.

Book references appear in this type-
face. 

Refer to Newton’s Telecom Dictio-
nary

A vertical bar | means “or”: only one 
option can appear in a single com-
mand.

platform [a|b|e]

Square brackets [ ] indicate an 
optional argument.

login [platform name]

Slanted brackets < > group required 
arguments.

<password>

Table 3 Keyboard and menu conventions 

Description Example

A plus sign +  indicates simulta-
neous keystrokes.

Press Ctrl+s

A comma indicates consecutive key-
strokes.

Press Alt+f,s

A slanted bracket indicates choos-
ing a submenu from menu.

On the menu bar, click 
Start > Program Files.
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Table 4 Symbol conventions

Table 5 Safety definitions

This symbol represents a general hazard.

This symbol represents a risk of electrical shock.

NOTE

This symbol represents a Note indicating related information or tip.

WARNING

Indicates a potentially hazardous situation which, if not avoided, could result 
in death or serious injury.

CAUTION

Indicates a potentially hazardous situation which, if not avoided, may result in 
minor or moderate injury.
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Chapter 1 Overview

This chapter provides a general description of the Hindsite. Topics discussed in 
this chapter include the following: 

– “About Hindsite” on page 2

– “What’s new in version 2.20” on page 2

– “Features and capabilities” on page 2

– “Options” on page 2
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About Hindsite

Hindsite is a very powerful application able to gather, analyse, display, and record 
data from many devices at the same time. It is made up of an integrated set of 
Software Components, each of which contributes to the overall application. 

What’s new in version 2.20

Please see chapter “Changes from Earlier Releases” on page 135.

Features and capabilities

Overlay real topographical maps with geographical information system

Set up rapidly with dynamic equipment control and configuration wizard

Analyze data powerfully

Report and export easily and flexibly

Test capacity of new technologies like CDMA2000, GPRS, TETRA and UMTS using 
a benchmark standard

Options

Hindsite is a software product supporting any of the following measurement 
receivers:

– Griffin Fast Measurement Receiver 8301, order code M 100 501

– Griffin Fast Measurement Receiver 8302, order code M 100 502

– GPR General Purpose Receiver 8103A, order code M 100 603

The software can be used with the following hardware options:

– JRC GPS Option (GPS Receiver, Mag mount antenna, cables, manual and 
carrying case), order code M 248 622

– Trimble 455 GPS Option (PS receiver, dead reckoning heading sensor, cables, 
manual, carry case), order code M 248 623

– GPR Distance Option (WHK1, PPA 9306, cables, manual and carrying case), 
order code M 248 624

– SMR Distance Option (WHK1, cables, manual and carrying case), order code 
M 248 625

– Pedestrian Distance Option (Thrumeter, PPA 9306, Computer Tray, cables, 
manual and carrying case), order code M 248 626
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Chapter 2 Introduction

This chapter explains the basic ideas and terminology used in the rest of the 
manual. The topics discussed in this chapter are as follows:

– “About Hindsite” on page 4

– “Basic terminology” on page 4

– “Known issues” on page 5
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About Hindsite
The purpose of Hindsite is to collect data from a selection of measuring instru-
ments and to display the data in a useful way. The data can be viewed both while 
it is being gathered and later, once it is stored in files.

Basic terminology
This section will introduce some of the terminology used within Hindsite. The 
topics here are all covered in detail in the later sections of the manual.

Instrument An instrument is a device that generates data to be recorded by Hindsite during 
a drive test. The obvious instruments are the GPR and Griffin series of measuring 
receivers and the Trimble or JRC Satellite Navigation Receivers. Hindsite also has 
instruments which are not so obvious, such as the event log which records any 
events raised by the instruments during a drive test, or markers where the data 
comes from you, the operator. 

View A view is a type of display of the data. Currently Hindsite has three views: graph, 
table and map. Each view appears as a separate window within the overall 
Hindsite window. You can have several views open at the same time.

Presentation Hindsite uses the term presentation to refer to a collection of views. For example, 
if you arrange a table and a graph to show some particular feature of the data 
in a drive test this would be a presentation of that data. You can save the presen-
tation within the drive test to return to it at a later time.

Configuration A configuration is a collection of instruments and views that you prepare before 
doing a drive test. In the configuration you can specify the settings for each 
instrument and which views are to be shown during the drive test. You can have 
as many configurations as you wish and simply choose the one you need for any 
drive test. You could prepare configurations on one PC and send them to other 
PCs running Hindsite to ensure that they all use the same settings.

Field A Hindsite field is a particular type of data, for example signal strength is a field, 
as is the 10% confidence value. Fields can be measured directly by the instru-
ments or calculated by Hindsite. The Hindsite views all show data from fields, for 
example, when you choose what to display as a line on a graph you are choosing 
what field to display.

Hindsite will only allow you to choose the fields that will be available from the 
instrument settings that you have chosen. If a field is not available to you it is 
because you did not choose the correct instrument settings to produce the field. 
See Chapter 7 “Hindsite Fields” for more discussion about fields.
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Drive test A drive test is the act of measuring with Hindsite and results in a drive test 
results file.

Drive tests are run using a particular configuration file and data is written to a 
drive test results file. This file contains a copy of the configuration that was used 
for the drive test so you can always find out precisely what settings were used 
by the instruments. You cannot change the settings for the instruments. 

The drive test results file also contains copies of the views that were in the 
configuration (in other words a copy of the presentation). You can change and 
then save the views within the drive test tesults file.

Known issues
The service for the wheel calibrator does not install for Windows 2000. This 
prevents distance-triggered runs with the GPR.

When installing under Windows NT and starting Hindsite for the first time, a 
message box appears stating 'unable to start Hindsite'. However Hindsite 
continues to load and is usable. Once Hindsite is licensed then this message no 
longer appears when you start Hindsite.

When working with the Griffin, it may happen that changing from dBm to dBµV 
does not change table and graph unit values.

Time-triggered route tracing is not supported by Hindsite.

Note

See also Chapter 8 “Maintenance and Troubleshooting”.
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Chapter 3 Installation

This chapter describes how to install the Hindsite. The topics discussed in this 
chapter are as follows:

– “Software requirements” on page 8

– “Hardware requirements” on page 8

– “Installing the software” on page 8

– “Licensing Hindsite” on page 9

– “Configuring the software” on page 15
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Software requirements
Hindsite is designed to run on the 32-bit Microsoft Windows operating systems 
Windows 95, 98, NT, 2000, and XP.

Hardware requirements
Hindsite is a very powerful application able to gather, analyse, display and record 
data from many devices at the same time. To obtain the best performance from 
Hindsite you should run it on a powerful PC platform. Willtek recommends that 
the minimum specification of PC is one with a 400 MHz clock rate fitted with 
64 megabytes of RAM. The size of hard disk depends on the volume of maps and 
data that you will need to store on it.

Installing the software
Two types of installation are supported – initial installation (for first-time use of 
Hindsite on a PC) and upgrade installation (installing a newer version over an 
older one).

Initial installation 1 Insert the Hindsite CD into the CD drive. The installation should start auto-
matically (if autoinsert notification is switched on). If the installation does 
not start automatically, you can install Hindsite either by running 
setup.exe directly from the Windows Run menu or through the 
Windows Control Panel Add/Remove Programs utility.
To install Hindsite from the Windows Run menu, choose Run from the 
menu. You can then browse on the CD to find setup.exe or, if you know 
the drive letter for your CD, type x:setup, where x is the drive letter. 
To install Hindsite via Control Panel, open Control Panel and then open Add/
Remove and choose Install.
Installation is handled through the industry-standard InstallShield Wizard. 
This will be familiar to anybody who installs programs regularly. It will guide 
you through several pages. In most cases you need only click on the Next 
button. 

2 On Page 1 of the installation (Welcome), follow the advice to close all other 
Windows applications.

3 On Page 2 (Identification), enter and confirm your name and organization. 
This will default to values you have used previously on this PC but you can 
change them if you wish.

4 On Page 3 (Installation Folder), you may specify any location for installation. 
The path to the folder will be created if necessary. The default should be 
acceptable in most cases.
Hindsite will now be installed.

5 The wizard might instruct you to restart your computer at the end of the 
installation. If it does, it is essential that you do so before running Hindsite.
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6 Click Finish to install the Hindsite program.

7 Run Start > Programs > Willtek > WheelInstall. When it has finished, 
restart your computer again.

8 Once the installation is completed, and you have restarted your PC, you 
should follow the instructions below to license Hindsite.

Upgrade installation If you already have Hindsite installed and are upgrading to a new release you can 
proceed as for the initial installation. 

Willtek recommends that you use the same folder for the new Hindsite so as to 
overwrite the previous release. Willtek does not support two different versions of 
Hindsite on one PC at the same time and they might interact.

None of your data will be affected by installing a Hindsite upgrade.

Please run WheelInstall (from Start > Programs > Willtek) after running 
setup.exe.

Licensing Hindsite
It is a deplorable fact of the world today that software is often stolen, which 
means that Willtek has to protect Hindsite. Unfortunately, it means that you, the 
legal user, has to enter a licence key to enable you to use Hindsite. Willtek has 
tried to make the process as convenient as possible, but, to be secure, it has to 
be well-protected against attack.

The licences are issued for a particular computer but may be transferred easily 
to another computer if required.

Some demonstration files are installed with Hindsite and these can be viewed 
freely without any licences. Viewing of other files and recording of new data can 
only be done with the appropriate licence.

Currently Willtek issues two types of licence: one which enables full operation of 
Hindsite and one which only enables viewing of drive test result files. Willtek will 
only issue the type of licence that you have purchased.

Obtaining your licence Once you have installed Hindsite on the PC on which you intend to use it, you 
must run the licence wizard and obtain a licence key from Willtek. You will need 
to be in contact with Willtek to obtain your key. You can use email, telephone or 
fax as convenient to contact Willtek’s technical support; see section “Technical 
assistance” on page xiv.

To register for your warranty support you will have to supply Willtek with the 
following information at the same time as you request your licence key:



Chapter 3 Installation
Licensing Hindsite

10 Willtek 8010 HindsiteTM RF Propagation Test Software Version 2.20

– Contact name

– Company

– Address

– Phone number

– Fax number

– Email address

You will need to quote your order number and, if you bought Hindsite through 
one of our distributors, the name of the distributor. If, for any reason, Willtek is 
not able to verify that you are the legitimate purchaser, Willtek will not issue a 
licence key. We are sorry if this happens to you, but we have had instances of 
people trying to obtain keys through deception and have to protect ourselves. 
The solution is to contact your distributor (or salesman if you bought Hindsite 
directly from Willtek) who will be able to arrange for a key to be issued to you.

Please note that Willtek will not reissue a licence once it has been issued to you, 
even for the same PC. You can transfer your licence from one PC to another as 
often as you wish. 

Running the licence wizard

From the Tools menu, select Licence Wizard . Hindsite will detect which 
licence, if any, is active on this computer and guide you through the steps neces-
sary to obtain the licence you require.

New licence If you have no licence the wizard will appear as follows:

Select which licence you have ordered and click Next.

Note

Willtek recommends that you read the following sections carefully before 
licensing your copy of Hindsite.
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A primary key will be displayed which must be sent to Willtek together with your 
proof of purchase and support registration details. The primary key contains, in 
an encrypted form, your licence type and a unique identifier for your machine 
(no private data is communicated to Willtek).

If you are in direct communication with Willtek technical support then obtain 
from them a secondary key and enter it immediately into the lower row of boxes 
(the same number of characters in the same groupings as in the primary key).

If there will be some delay before obtaining the secondary key, click the 
Suspend Wizard awaiting Secondary Key... button. The wizard will exit. You 
will not be able to use Hindsite until you get the secondary key. 

When the secondary key has been obtained, start the licence wizard again as 
before and the wizard will redisplay the page for entering the secondary key as 
described above.

Once the secondary key has been entered, click the Finish button. You will now 
be able to use Hindsite.

We will issue a secondary key, which must be entered in the appropriate boxes.

If you cannot obtain a secondary key immediately, click the Suspend Wizard 
awaiting Secondary Key… button. This will close the wizard and, the next 
time the wizard is started, will take you straight to this page with the same 
primary key.

When the secondary key has been entered, click Finish to complete the licensing 
process.

Upgrading from viewer to full
licence

If you have a viewer licence and are going to upgrade to a full licence (or transfer 
the licence to another computer) the wizard will appear as shown below:
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You may upgrade to a full licence or transfer the viewer licence to another 
computer. Select which you want and click Next.

If you are upgrading, the subsequent steps are identical to those above (under 
New Licence).

Transferring a licence If subsequently you want to transfer your licence to another computer, you can 
do this without reference to Willtek.

The idea is that the original computer can act as a source of the secondary key 
instead of Willtek. In doing so, the original computer will delicense the copy of 
Hindsite on itself so that only one computer can hold a licence at any time. You 
can transfer the licence back to the original computer at a later time.

Note that you must have both the source and target computers in communica-
tion while transferring the licence as the keys incorporate the time and date. 
Once you generate a secondary key on the source computer then you must use 
it on the target computer immediately. If you rerun the licence wizard on the 
target computer then it will generate a different primary and so will need a 
different secondary key, but you will not be able to generate another secondary 
key on the source computer.

When you are ready, install Hindsite on the target machine as normal. Run 
Hindsite and start the licence wizard as described above in “Obtaining your 
licence” on page 9 until you reach the page that requests the secondary key.

Now run the licence wizard on the source computer but select Transfer 
Licence(s) on the opening page. Click Next. 



Chapter 3 Installation
Licensing Hindsite

Willtek 8010 HindsiteTM RF Propagation Test Software Version 2.20 13

Enter the primary key from the target computer. Once you have entered the 
complete key and Hindsite has checked that it is valid, the page will change to 
the following:

Click Generate Secondary Key. You are strongly advised to make a note of the 
secondary key.

Now type the secondary key into the target computer. When the target computer 
has been licenced successfully, click Finish to exit the wizard on the source 
computer. The copy of Hindsite on this computer will now be unlicensed.

Note

The next step will display the secondary key (to be entered on the target com-
puter) and simultaneously erase the licence from this computer. There is no 
way of undoing this. 

Please ensure that the primary key is entered correctly and that you are ready 
to copy the secondary key to the target computer immediately before con-
tinuing.
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Transferring a full licence If you already have a full licence when you start the licence wizard then the only 
available action is to transfer the licence to another computer. To do this, click 
Next and then proceed as described above.

Installing maps The installation process will copy some map files into a subfolder of the instal-
lation folder so that the demonstration run files may be viewed. The registered 
Hindsite maps folder will be set to this subfolder.

In order to use your own maps, you must copy them onto the hard disk in your 
PC and then set the maps folder (in the Tools > Working Folders menu, as 
explained on page 15) to point to them.

You must not load your maps in the default subfolder with the demonstration 
maps.

The background maps can be presented to the map view in any form handled by 
the MapInfo product that it uses. In the folder specified to Hindsite for maps (see 
“Working folders” on page 15), the map view first searches for a .gst (geoset) file. 
If it finds one, it is loaded into the MapInfo product for display. Failing that, all 
the .tab (table) files in the folder are loaded in. The .gst and .tab files and any 
associated files (for example bitmaps) must be in the correct format for MapInfo 
products.

Note

You must not mix maps with different projections or formats in the same 
folder. If you do so it will cause problems with the display of maps.
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Configuring the software

Working folders Once you have installed Hindsite you should select the folders in which you will 
store your data. Start Hindsite, then select Working Folders from the Tools menu.

You will be able to select default locations for the folders to hold your configu-
ration and run (drive test result) files. You can also select the folder containing 
your maps.

Demo files Some demonstration files are copied to your hard drive when Hindsite is 
installed. The drive test result files can be viewed even if Hindsite is not licensed. 
The demo files include some tiles of a map of the UK.

Some facilities are shared by many of the Hindsite components (instruments or 
views). Rather than repeat the same information in the chapters for each compo-
nent the shared facilities are described in this appendix.

Communications settings Some facilities are shared by many of the Hindsite components (instruments or 
views). Rather than repeat the same information in the chapters for each compo-
nent the shared facilities are described here.

All of the instruments communicate with Hindsite via an RS-232 connection and 
their settings editor will contain the communications tab. You should ensure that 
the settings are suitable for the instrument and match the actual settings in the 
instrument.
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This specifies the RS-232 settings to be used during a run. If the COM port 
number can be assured, it may be specified here. If it may vary from drive test to 
drive test (this configuration file could be used on more than one computer), you 
may specify that it is requested at run time.

RS-232 Settings… Port

Select the required port number from the drop-down list.

Baud Rate

Select from the drop-down list.

Data Bits

Select from the drop-down list.

Parity

Select from the drop-down list.

Stop Bits

Select from the drop-down list.

Flow Control Select from the drop-down list.

Carrier Detect Select from the drop-down list.

Defaults To reset all the above values to their default values, click this button.

Test If the instrument is actually connected to the computer, you may test that the 
communications parameters have been specified correctly. Click the Test button 
and the instrument will be prepared for a run (although no measurements will 
be taken). If the communication fails, Hindsite will attempt to diagnose the 
problem for you.
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Chapter 4 Using Hindsite

This chapter describes the basic functionality of Hindsite. Topics discussed in this 
chapter are as follows:

– “Basic elements and usage” on page 18

– “Creating configuration files” on page 20

– “Running a drive test” on page 26

– “Viewing drive test results” on page 38

– “Printing your results” on page 39

– “Exporting your results” on page 40

– “Changing the coordinate system” on page 42

– “Managing Hindsite” on page 43
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Basic elements and usage

The Hindsite window
interface

Windows applications have a number of standard interfaces that they can show 
to you, the user. The one chosen for Hindsite is called MDI or multiple document 
interface. This is the one used by many applications such as Word and Excel. 
Unfortunately, this interface does not quite meet the needs of an application 
such as Hindsite, which needs to show many different views of the same file. 
Willtek has had to use the MDI interface in a way which differs slightly from that 
which is conventionally used.

Each view is an MDI child window. When you close a view you do not close the 
whole file, only that view of it. To close the file (and hence all of its views) you 
must choose Close from the File menu.

If you maximize a view with the maximize button in the top right of its title bar, 
all of the views will be maximized and placed one on top of another. (This is the 
MDI standard way of handling multiple windows.) The minimize, restore and 
close buttons will move to the menu bar. If you then close the uppermost view, 
you will see another view under it. The one exception to this is the map view 
designated as background which remains maximized irrespective of the other 
views.

Overview of activities When working with Hindsite you will find yourself tackling four main tasks:

– Preparing configurations

– Performing a drive test

– Analyzing the drive test results

– Exporting results

Each of these tasks will be overviewed below and expanded in the following 
sections and chapters of this manual.

Planning a drive test When planning a drive test you will need to plan precisely what you need to 
measure and how best to do so. For example, you might have to choose between 
a range of instruments and navigation devices. You might or might not have 
maps available for the area, which will influence how you choose to navigate. 
You will need to decide what measurements to make and on which frequencies 
as well as practical issues such as which COM ports to use. Finally, you might 
need to prepare a written procedure to ensure that a sequence of drive tests are 
all carried out in the same way by the operator.

Experience with drive testing and Hindsite will allow you to make the best 
choices in different circumstances. The result, as far as Hindsite is concerned, of 
the planning phase is a configuration file containing all of the settings you have 
chosen.
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Performing a drive test Once you have planned a drive test actually doing the test should be an auto-
matic process. However, even the best laid plans can be upset by road works and 
weather so Hindsite has facilities to help to monitor and track precisely what 
does happen.

Starting a drive test is as simple as opening the configuration and clicking on 
Run. You can choose what data is visible during the drive so that you can 
monitor whether it is going to plan or not. For example, you might show a graph 
of signal strength to give yourself confidence that the data is being collected.

Analyzing the drive test results Having recorded your drive test results, you can then return to them time and 
time again to analyze the data in different ways. You can replay the drive in real 
or accelerated time to see again the sequence of events. Hindsite allows you to 
inspect parts of your data in great detail by zooming in or by changing the views 
themselves. Some of the data that you can see is the raw data as recorded but 
other data, such as carrier to interference ratio, is the result of Hindsite analyzing 
the raw data in different ways. Finally, you can export the raw or analyzed data 
in standard formats for input into other applications.

Toolbar shortcuts References are made in this manual to menu items that should be selected to 
perform certain operations. For many of these menu items, a toolbar shortcut 
button is provided. Where this is the case, the button image will be shown in the 
manual. It should be noted that the toolbars are fully customizable and the 
customizations will be saved, so that a button might not be present if a previous 
user has changed the toolbars. 

Licensing Hindsite Two types of licence are available – full and viewer. The full licence enables you 
to perform all functions of Hindsite whereas the viewer licence disables the 
recording of data. Hindsite contains a licence wizard that will guide you through 
the steps necessary to obtain licences. 

Licences are only valid for a particular computer. If you wish to transfer the 
licence to another computer, you can (through the licence wizard) but that will 
disable it on the original computer.

For demonstration purposes, some files are installed with Hindsite; these can be 
viewed freely with no licences.

Starting Hindsite The installation process will have put a new item called 'Willtek' in the Programs 
section of the Start menu, this contains an icon for Hindsite. Click on the icon to 
start Hindsite.

When Hindsite starts it displays a message indicating the version of Hindsite 
being used, the current PC time and the current time zone setting as determined 
from Windows. These are shown so that you can check if they are correct for your 
current location before recording data. If these are incorrect and you wish to 
change them, close Hindsite and adjust the date and time through the Windows 
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control panel. If you have travelled across time zones with your PC, an incorrect 
setting could cause confusion between any times that you note from your watch 
(presumably local time) and the time logged by Hindsite from the PC clock.

Incorrect settings here can, under some circumstances, affect the time taken by 
the GPS receiver to acquire the satellites. The GPS system works to Universal 
Time (UT), the replacement for Greenwich Mean Time (GMT). 

If you missed the initial message when Hindsite started you can see it again by 
selecting the Help > About Hindsite menu.

Once Hindsite is started, it waits for you to open a file or create a new configu-
ration. 

Closing files Willtek recommends that you use the Close option on the File menu to close both 
configuration and drive test result files. This is because the changes that Willtek 
made to the conventional use of the Windows Multiple Document Interface 
could lead to confusion. The top-right 'cross' button on a window conventionally 
closes a document (or file). Willtek uses this button to close the view of the 
document but, since there can be many views of the same document, Willtek 
does not use it to close the whole document. This can lead you to think that you 
have closed a document when, in fact, you have only closed one view from it.

Creating configuration files
Configuration files contain details of which instruments are required for a 
particular type of drive test and their settings. We suggest that you store them 
in appropriately named folders for easy retrieval. 

They can also contain views to be used as defaults during a drive test and when 
viewing its results.

Types of view Hindsite features three types of view: graph, table and map. Each may be config-
ured through its editor to show the data that is available in the results file.

All views behave just like any other window: they may be sized and shaped by 
dragging on their border.

Once you have added a view you can then change it in almost any way to suit 
your needs for analyzing the data. Refer to Chapter 6 “Managing Views” for 
details of how to change the appearance and content of views. 

Base views To save your time in setting up views, a selection of prepared base views are 
provided with the system. These are detailed under the descriptions of the 
various views.
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Hindsite analyzes the settings in the configuration to decide on which base views 
can be used with the available data.

Only those views which can be used with the settings or data available will be 
shown. For example, if you have not measured on multiple frequencies the views 
showing carrier to interference ratio will not be available; they will be shown 
greyed.

You can easily add views of your data to the screen either by clicking on the tool 
button or via the View > Presentation > Add View menu.

Base graph views

Signal level graph The signal levels for the different percentages are plotted against distance or 
time. The default percentages are 10%, 50% and 90%. The horizontal axis is set 
at distance if it was recorded, otherwise time.

Confidence graph The confidence intervals for the signal levels stored in the results file or chosen 
in the configuration are plotted against distance or time. The horizontal axis is 
set at distance if it was recorded, otherwise time.

C/I graph If multiple frequencies have been chosen in the measuring instrument within the 
configuration, this will be available with a choice of any of the frequencies as 
the carrier, any other frequency as the interferer and a choice of threshold. 
Hindsite calculates the carrier to interference ratio and plots those C/I values 
above the threshold.

Base table views All base tables contain, in the first column, the distance, time into run or time of 
day according to what is available. If positioning information is available, the 
second and third columns contain either longitude and latitude or Easting and 
Northing, again according to what was recorded.

Subsequent columns contain values according to the type of table.

To load a base table, select the View > Presentation > Add View menu. A 
submenu will drop down which will include an item for each table:

Percentage table The signal levels for the requested percentages are displayed across the right-
hand columns.

Confidence table The confidence intervals for the signal levels stored in the results file or chosen 
in the configuration are displayed across the right-hand columns.
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C/I table If multiple frequencies have been chosen in the measuring instrument within the 
configuration, this will be available with a choice of any of the frequencies as 
the carrier, any other frequency as the interferer and a choice of threshold. 
Hindsite calculates the carrier to interference ratios and tabulates those values 
above the threshold.

Best server table A best server table lists the best server chosen from the frequencies measured. It 
is only available if you have measured multiple frequencies. On every row of the 
table, the cell with the greatest signal level is colored red. 

Event table The event table lists all the events reported by the instruments during the drive 
test. These events will include information as well as warnings of problems that 
occurred, such as loss of communications.

Composite coverage table A composite coverage table lists the highest signal strength and also the 
frequency (server) that it corresponds to. It is only available if you have measured 
multiple frequencies.

Base map views

Signal level map A signal level map plots the measured signal level against position. If multiple 
frequencies are being measured, the level for the first one is plotted. If percent-
ages or confidence intervals are being recorded the first one is plotted. The route 
can be shown colored according to the level and it can be annotated with the 
actual measured values.

Best server map A best server map plots the best server chosen from the frequencies measured. 
It is only available if you have measured multiple frequencies. The route is 
colored according to the frequency (server) with the greatest signal level at that 
point, and it can be annotated with the frequency.

C/I map If multiple frequencies have been chosen in the measuring instrument within the 
configuration, this will be available with a choice of any of the frequencies as 
the carrier, any other frequency as the interferer and a choice of threshold. 
Hindsite calculates the carrier to interference ratios and plots those values above 
the threshold.

Composite coverage map A composite coverage map plots the highest measured signal level from the 
frequencies being measured. It is only available if you have measured multiple 
frequencies. The route is colored according to the highest signal level and is 
annotated with the frequency (server).
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Using the GPR
configuration wizard

Hindsite contains a configuration wizard that enables easy construction of a 
configuration file for use with a Willtek GPR series receiver. While within the 
wizard you can click on <Back to return to earlier steps. Once you have 
completed your selections from a page click Next> to move on to the next page. 
To start the wizard select the File > New Configuration menu  and choose 
to use the GPR configuration wizard. The wizard will start with its first page.

You can also use the wizard to edit an existing configuration as follows. First 
open the configuration you wish to change and then choose Apply Wizard from 
the configuration menu.

Page 1 - Model selection Select the GPR model from the drop-down list.

If you are using the 8181 GPR Down Converter (1700 to 2500 MHz) then ensure 
that the GFC Selected check box is enabled.

Page 2 - Measurement mode You must now choose between a single frequency - multiple sample run or a 
multiple frequency - single sample run.

In a single frequency - multiple sample run the GPR will take many samples on 
a single frequency and report the percentage levels or confidence intervals to 
Hindsite.

In a multiple frequency - single sample run the GPR will cycle around up to 10 
frequencies taking a single sample on each one.

Choose the IF bandwidth to suit the radio system that you are measuring. In 
general, you should use the narrowest bandwidth for CW measurements.

If this is to be a pedestrian run, where you walk rather than drive the route, then 
enable the Pedestrian Run check box. This will change the distance units to cm.

Page 3 - Measurement details This page will change depending on whether you have chosen to do a multiple 
sample or a single sample run.

Multiple sample run

This will show the frequency and the percentages chosen. These will be default 
values until you change them. To change the values click on the Edit button to 
bring up the multiple sample editor. Make the settings you wish and then click 
OK. (Refer to “Multiple Samples tab” on page 48 for instructions on these 
settings.)

Single Sample run

This will show a list of the frequencies chosen. This list will be empty until you 
add some. To add frequencies, click on the Edit button to bring up the single 
sample editor. Add the frequencies you wish and then click OK. (Refer to “Single 
Sample tab” on page 49 for instructions on these settings.)
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Page 4 - Triggering and
navigation

You can choose how to trigger the collection of data. The trigger can be either 
every x seconds or every y meters. The choice depends on what sort of measure-
ments you wish to make. Note that the distance trigger will only work if you have 
a distance transducer connected to the parallel port of the PC via a PPA9306 
adapter.

Once you have chosen the triggering mode choose how often to trigger the 
measurement.

If you have chosen to use distance triggering you must select a wheel transducer calibra-
tion. This is used by Hindsite to calculate how many pulses per meter your wheel trans-
ducer produces on your vehicle. Every vehicle should be calibrated, as the number of 
pulses per meter will depend on the wheel diameter. 

To calibrate the vehicle immediately, first ensure that the wheel transducer is 
connected to the parallel port of the PC via a PPA9306 and then click on the Cali-
brate… button. Follow the instructions in “Calibration…” on page 52.

Note that distance transducers have a limited resolution and this can affect the 
spacing of triggers. This issue is addressed in the appendix “Applications of the 
Griffin” on page 105.

If you are going to use a GPS navigation receiver you should select it from the 
list of receivers, assign it to a COM port and set the communications parameters.

Page 5 - Views When you move to the next page there will be a short delay whilst Hindsite 
analyzes the settings you have chosen and creates some compatible base views 
to be included in the configuration. It will then add all the views to the list. 

You can choose to remove any view by selecting it and then clicking on the 
Remove button.

You can add a view from the toolbar by clicking on the tool button. If you hover 
over the tool button a tool tip will appear to let you know which view the tool 
button will add.

Page 6 - Notes The sixth page allows you to enter any notes to remind yourself or other users 
about the purpose of the configuration.

Once you have entered any notes press Finish button to complete the configu-
ration. You will be prompted for a file name to call the configuration. Once you 
have saved the configuration you can start a drive test immediately.

Manual configuration To create a new configuration without using the wizard, first select the File > 
New Configuration menu  and then choose not to use the GPR configuration 
wizard. Choose a name and location for the new file. The name of the file will be 
displayed in the title bar of the Hindsite window and the configuration menu will 
be enabled.
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Alternatively you can base the new configuration on an existing one. First open 
the existing configuration then choose Save As from the File menu. Give the 
configuration a new name and then modify it by removing or adding instruments 
or views as required.

Adding an instrument To add an instrument to the configuration, select the Configuration > Add 
Instrument menu. A submenu of available instruments will be shown with those 
already in the configuration disabled. Select the instrument you require and its 
settings editor will be displayed with default settings shown (see “Using 
Measuring Instruments” on page 45 for details of individual instruments). 
Complete the settings and click the Editor's OK button to complete the addition 
of the instrument. Clicking the Cancel button will leave the configuration 
unchanged.

Removing an instrument To remove an instrument from the configuration, select the Configuration > 
Remove Instrument menu. A submenu of instruments in the configuration will 
be shown. Select the instrument you wish to remove.

Changing an instrument's
settings

To change the settings of an instrument already added to the configuration, 
select the Configuration > Edit menu. A submenu of the instruments in the 
configuration will be shown. Select the one you wish to change and its settings 
editor will be shown with its current settings (see “Using Measuring Instruments” 
on page 45 for details of individual instruments).

Make your changes and click the editor's OK button to store the changes. 
Clicking the Cancel button will leave the instrument unchanged.

Adding a view Select the View > Presentation > Add View menu. A submenu of all the avail-
able base views appears. Select the one required and it will appear in a default 
position and with a default size.

Move and size the view to give the appearance that you want for the configura-
tion you are constructing.

Removing a view Select the View > Presentation > Remove View menu. A submenu of Views 
in the configuration appears. Select the one you wish to remove.

A simpler way is to close the view's window by normal Windows operations.

Note

Once you have changed the settings of any instrument in the configuration, 
you MUST remove ALL of the views and replace them so that they are able to 
utilize the changed setting(s).
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Modifying a view's appearance Select the View > Presentation > Edit View menu. A submenu of views in the 
configuration appears. Select the one you wish to modify and its settings editor 
will appear with its current settings (see separate sections for details of indi-
vidual views). 

Make your changes and click the editor's OK button to store the changes. 
Clicking the Cancel button will leave the view unchanged.

Opening a configuration
file

Before a drive test can be run, a configuration file must be open. This will be the 
case after creating a configuration file but another one may be opened from the 
File > Open Configuration… menu . Alternatively, a recently used one may 
be opened from the first section of the recent files on the File menu.

Modifying a configuration
file

You can make whatever changes you wish to a configuration file and then save 
it under its original name or under a new name. If you are going to save it under 
a new name then it is a good idea to save it under the new name before changing 
it. This avoids accidentally overwriting the original configuration.

You can change the settings for the instruments and views or add or remove 
instruments or views.

Reinitializing views If you change anything in a configuration then you must reinitialize all of the 
views to make them adopt the new settings. You do this by deleting each view 
and reinserting it.

Running a drive test
Once a suitable configuration file is opened, a drive test may be run. Running a 
drive test will create a single drive test results file. Contained within it is a copy 
of the configuration file used so that the settings for a drive test can be exam-
ined.

Ensure that all the configured instruments are connected correctly to the 
computer, that the aerials are attached and that you are fully prepared for the 
test.

Willtek strongly recommends that you close any unnecessary applications, as 
these will consume resources that might be needed by Hindsite.

If you are going to use a distance transducer, and the vehicle has not been cali-
brated you should calibrate it now (see “Wheel calibrator wizard” on page 65).

Create or open a configuration file as described in the previous section. Make any 
changes to the settings (not forgetting to reinitialize the views, see page 26) 
then, if you wish, save the modified file, for example, you might need to select 
the frequencies on which to measure.
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Select the Run > Record menu . What you see next will depend on whether 
you have changed the configuration or not. This can be confusing at first so take 
your time and read the titles for the dialog boxes.

If you have changed the configuration, you will see a dialog box asking whether 
you want to save the changes to the configuration. Click Yes to update the 
configuration file, No to leave it unchanged or Cancel to stop the run. Note 
that, even if you choose not to save the modified configuration, whatever 
changes you have made will be saved in the copy of the configuration inside the 
drive test results file. At this point the configuration file is closed and cannot be 
affected by subsequent changes.

You will then see the familiar Windows file save dialog where you can choose the 
destination for the drive test results file. You can change the destination folder 
or create a new folder in the usual way. You can then type a name for the new 
drive test results file or select an existing one to replace. If you have chosen to 
replace an existing file, you will be asked to confirm that you want to replace it. 

The drive test results file is then created. This file is updated regularly during the 
drive test so that, should anything fail during the test, the data that you have 
already gathered is safe.

Preparing instruments Once you have specified the file name for the results file, the drive test will start. 
Hindsite will first prepare the configured instruments. This may take a few 
seconds. Progress may be shown for some instruments as Hindsite transmits 
settings to the instruments.

If there is any problem communicating with an instrument, the preparation 
dialog will show what is wrong. If you can rectify the problem immediately, click 
the Retry button otherwise click the Abort button to terminate the drive test. 
Once you have overcome the problem, you can start the drive test again.

Sometimes an instrument gives a warning during the prepare phase, for example 
the GPR will report a low battery. Since this is only a warning and the instrument 
can work, you can press the Ignore button to ignore the problem and continue 
to start the drive test.

Recording data Hindsite will automatically record all data, generally in its raw form, to the drive 
test results file. To guard against loss of data in the case of computer failure, 
Hindsite will ensure that data is actually recorded in the file (rather than just in 
memory) at frequent intervals.

You should ensure that sufficient free disk space exists before you start a drive 
test. If disk space is exhausted during a drive test, Hindsite will have no option 
but to terminate the drive test at that point. The amount of disk space required 
will depend upon which instruments are configured and their settings. 
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Willtek cannot give precise guidance on your disk space requirements since there 
are so many variables; it is probably better to run a few short, typical drive tests 
and extrapolate the resultant file sizes. Willtek recommends that you do not use 
a floppy disk as the destination for the drive test. It is preferable to record the 
file onto a hard disk and later to copy it to a floppy disk.

Status bar During a drive test, the status bar at the bottom of the screen will contain two 
panels.

Left-hand panel The left-hand panel will show the progress of the drive test. As each instrument 
is prepared and as each one is started, a message is displayed to that effect.

During data recording, a 'test running' message scrolls across the panel.

If the drive test is paused, a 'run paused' message flashes.

When the drive test is stopped, a 'run stopping' message flashes whilst any 
remaining data is copied from memory to the file. When this is complete, a 'run 
stopped' message is displayed.

Right-hand panel If, during a run an instrument detects a problem, which may affect the accuracy 
of results, an explanatory message is displayed with a flashing red cross. In some 
cases, Hindsite will consider the problem to be such that the drive test has to be 
stopped and so will stop the drive test automatically. In other less serious cases 
you should take corrective action as quickly as possible.

After five seconds, the red cross will disappear and the text of the problem 
message will turn grey. This is to avoid confusion between a problem that is 
repeating regularly (which will cause the red cross to remain and the text to stay 
black) and a problem that has now gone away. 

Inserting markers During a run, Hindsite allows you to mark significant points on the map which 
are then linked to the measurements. This can be useful for annotating maps and 
measurement results, for example when passing a bridge, a tunnel or a 
skyscraper during drive testing.

The marker is set using an alphanumerical key; before the run, you can assign 
meanings to the individual keys using the marker icon on the Hindsite toolbar.

Markers appear on map views as a red cross and on graph views as an annotated 
red line. (You can turn off the display of markers on the graph view.) They do not 
appear directly on table views but you can include a marker column in a table 
view.
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Assigning meanings to
keyboard markers

1 Click on the marker memo/notes icon . A form box will open, listing the 
code keys and type.

2 To add a description to a key, left-click in the white box next to the key and 
type in the description (for example, use B for bridge). The exception to this 
rule is W. This is treated as a constant and is a waypoint.

3 Continue this process to assign meanings to the keys. 

4 If you want you can press the Print button to print the table.

5 To close the form box, push the X in the top right corner.
The box can be reopened and changed at anytime.

An example of a resulting graph is shown below.

Note

Previous versions of Hindsite offered three different markers (position marker, 
suspect point marker, suspect region marker). On request by many users, these 
have been replaced by the new keyboard marker which makes operation even 
more comfortable.
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Adding markers during a run 1 During a run push the corresponding character on the keyboard that gives 
the meaning to the event. Map and graph are updated automatically by 
displaying marker keys in their views.

2 Repeat the process for the duration of run.

Route tracing The route tracing function can be used to map results with a route without using 
a GPS instrument. The procedures described here apply to out-door measure-
ments; in-door route tracing is described in a section further below.

Waypoints can be used for route tracing when there is no navigational device 
and the run is distance triggered. See below for instructions how to add 
waypoints to a route.

Route tracing can be performed directly after a run.

.

Note

Waypoints are sequential and must be traced through in the correct order.

Note

Waypoints cannot be moved, but markers will be repositioned along a route 
trace.

Note

All views should be closed and reopened after a route trace so the correct 
information is displayed.

Note

All distance-triggered runs can be retraced by repeating the steps below.

Note

Route tracing can also be applied to run files created with previous versions of 
Hindsite.
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Prerequisites: 

– A configuration file must be loaded with no GPS instrument.

– A map view must be opened before the start of a run.

Adding waypoints to a route
during a run

1 Create a configuration that is distance or time-triggered.

2 Open a map view and press the Record button.

3 After the Griffin or GPR have gone through preparation, a dialog box will 
appear asking for starting coordinates either using easting/northing or 
longitude/latitude. Select the desired option, enter your start coordinates 
and press OK.

As long as you have the necessary map(s) in the map folder, your general 
location will be displayed in the map view centered around the coordinates 
entered. The view can be manipulated with the pan  and zoom  
icons.
It is a good idea to have the vehicle stationary during this preparation stage.

4 Waypoints are added by placing the mouse pointer where the waypoint is 
going to be placed and then shift+left-click to place the waypoint. 
It is also possible to add keyboard markers during run.
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At this stage there will only be waypoints visible on the map (see figure 
above).

5 When the run is complete press the Stop button.

Route tracing with no
waypoints in the run file

1 Open a distance or time-triggered run file and click on the route trace icon 
 . This can be a normal run file or a previously route-traced file or even a 

run file that did use a navigational device. If the run file has views open, 
close them all down.

2 If the map has not been previously route-traced and there are no markers, a 
blank map view (untitled) and a dialog box will appear asking you for start 
coordinates either using easting/northing or longitude/latitude. Enter the 
start coordinates and press OK.
As long as you have the necessary map(s) for the location it will be displayed 
in the map view. The view can be manipulated with the pan  and zoom 

 icons. Apart from when the hand icon is selected, the mouse pointer 
will be seen as a cross hair.

3 Place the cross hair on the map where the run was started and left-click. 

4 Place the mouse pointer on another position along the route and left-click. 
This will draw a straight line between the two points.

5 Continue this process until the end of the run position is reached.

6 Click the route trace icon again to end. 
The map will now update itself and color the route plot according to the 
map legend that will be generated.

Route tracing with waypoints
on the run file

1 Open a distance or time-triggered run file and click on the route trace icon 
 . If any views are open, close them.

2 An untitled map view will open displaying a background map overlaid by 
waypoints. The view can be manipulated with the pan  and zoom  
icons.
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3 Place the mouse pointer on the map where the run was started and left-
click. 

4 Place the mouse pointer on another position along the route and left-click. 
This will draw a straight line between the two points.
The first waypoint that the route trace needs to go through will be high-
lighted in red. Once clicked on, the next waypoint in the sequence will high-
light red.

5 Continue this process until the end of the run position is reached and all 
waypoints have been clicked upon.

6 Click the route trace icon again to end. 
The map will now update itself, and color the route plot according to the 
map legend that will be generated.

In-building route tracing Hindsite can also be used to provide in-building coverage maps, which often do 
not use a Geoset coordinate system but rather coordinates relative to a corner of 
the map or a central point. 

Waypoints are used to mark the route taken; so an in-building run file must 
contain waypoints.

Note

Remember to directly click on highlighted waypoints and not just pass 
through them when route tracing.

Note

Waypoints are sequential and must be traced through in the correct order.
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.

Managing an in-building plan
run

1 Create a configuration that is distance or time-triggered.

2 Open a map view and then click on the in-building icon  (this is found in 
the task bar and is only visible when a map view is open). 

3 Push the record icon .

4 After the Griffin or GPR have gone through preparation, a dialog box will 
appear requesting a building plan to open. Select the appropriate tab file 
and press OK.

Note

Waypoints cannot be moved, but markers will be repositioned along a route 
trace.

Note

All views should be closed and reopened after a route trace so the correct 
information is displayed.

Note

All distance or time-triggered runs can be retraced by repeating the steps 
below.
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5 The building plan will now be visible in the map view. The map view can be 
manipulated by using the pan  and zoom  icons.

6 Waypoints are added by placing the mouse pointer where the waypoint is 
going to be placed and then shift+left-click to place the waypoint. It is also 
possible to add keyboard markers during the run.

At this stage there will only be waypoints visible on the map.

7 When the run is complete press the Stop button.
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Route tracing an in-building
run file

1 Open a distance-triggered run file. This can be a previous route-traced file.

2 Click on the route trace icon .
An untitled map view will open displaying the in-building plan overlaid by 
waypoints. The view can be manipulated with the pan and zoom icons.

3 Place the mouse pointer on the plan where the run was started and left-
click. 

4 Place the mouse pointer on another position along the route and left-click. 
This will draw a straight line between the two points.
The first waypoint that the route trace needs to go through will be high-
lighted in red. Once clicked on, the next waypoint in the sequence will high-
light red.

5 Continue this process until the end of the run position is reached.

6 Click the route trace icon again to end. 
The map view will now update itself, and color the route plot according to 
the map legend that is generated.

Pausing a drive test Recording of data may be paused by selecting the Run > Pause menu . No 
more data will be collected from instruments until the drive test is resumed. Data 
already received will be processed and stored in the file. 

Resuming a drive test A paused drive test may be resumed by selecting the Run > Pause menu  
again. Data collection will resume immediately.

Viewing data while
running

The drive test will start by default with the views that were included in the 
configuration file. These views may be moved and resized freely whilst the drive 
test is running.

The appearance of views may be changed as described in Chapter 6 “Managing 
Views”. All views will update their display of the data as frequently as they can, 
within the capabilities of the computer. It may well happen that, within this 
interval, a number of measurements have been taken. In this case, all the 
measurements since the last display will be added to the view so no readings will 
be missed.

Hindsite gives priority to recording data to file rather than displaying it on the 
views. This can lead to the views updating slowly if the computer is not powerful 
enough for the application.  

Note

Remember to directly click on highlighted waypoints and not just pass 
through them when route tracing.

Note that, whilst the drive test is paused, some data might be lost. This might 
affect the integrity of the results.
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Stopping a drive test Select the Run/Stop menu . Collection of data will cease immediately, all 
received data will be processed and written to the file, views will be updated 
finally and a run notes dialog will be displayed. 

The Griffin instruments can contain a large buffer of data which might continue 
to be collected after you have stopped the drive test.

Editing run data notes Run notes provide an opportunity for notes to be made about the drive test. 

Details of the transmitter, cell and antenna of interest may be noted together 
with any free-form notes you require.

These details will be stored on the drive test results file and may be viewed 
subsequently. Any parameters will be included in an exported file if they are 
included in the target format.
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Viewing drive test results
Results of a completed drive test may be viewed. They will be available immedi-
ately after running a drive test or after opening a drive test results file through 
the File > Open Run File(s)… menu . Alternatively, a recently used one may 
be opened from the second section of the recent files list on the File menu.

The drive test results file will be loaded and the views that were open when it 
was saved will be reopened.

Although the data itself cannot be changed in a drive test results file, the views 
of it may be changed freely. Any such changes made whilst viewing can be saved 
to the file when it is closed.

Manipulating views All views in Hindsite operate in a similar way. When you select a view, the main 
view menu will be extended with further items to allow you to change the view 
that is selected. (The Windows title bar of the selected view is a different color 
to the other title bars.) These extra items will also be contained in extra toolbars 
that are shown and hidden by Hindsite as necessary.

You can move and resize views on the screen as you wish. You can change the 
appearance and contents of views by editing them with their editors. Details of 
how to manipulate views can be found in Chapter 6 “Managing Views”.

Replaying a drive test A drive test may be replayed at speeds ranging from the original recording speed 
to 1000 times the original. Select the Run > Play menu . A replay control will 
be shown:

The visible views will reset to show no data and then the drive test will be 
replayed, initially at the original rate. 

Varying the rate of replay If you wish to change the rate of replay, drop down the list at the left and select 
the rate you require. A selection of rates between real time and 1000 times orig-
inal rate is available. The rate may be changed at any time during the replay.

Repositioning the current
replay position

The position along the route may be changed at any time during the replay by 
dragging the slider to the left or the right. When the slider is dropped, the current 
position is adjusted to that point and the replay continues. The slider scale repre-
sents the elapsed time of the drive test, not distance.
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Printing your results
While viewing the results of your drive tests you can print reports in various 
formats. In addition, you can print the map at various scales (see “Printing the 
map” on page 83).

Print screen To print an image of the screen precisely as you can see it, choose File > Print 
Screen.

Print… To print a report of the results choose File > Print… This will bring up a dialog 
box with two tabs that allow you to select what to print and to control the 
format of the printing.
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Settings tab Instruments

The instruments box will list all of the instruments in the configuration. Click on 
the check box next to an instrument to include its settings in the report. You can 
use Select All and Deselect All to help you choose all or none of the instru-
ments.

Results

The results box will list all of the views in the configuration. Click on the check 
box next to a view to include it in the report. You can use Select All and Dese-
lect All to help you choose all or none of the views.

Normally the views are printed in portrait format. You can force the graphical 
views to be printed in landscape format by checking the Force Landscape box.

Header and footer

You can choose a combination of page numbers and or file name to be included 
in the header and footer printed on each page.

Print setup

Click on the Print Setup button to choose which printer to be used.

Print preview

Choose either Thumbnail to see a compressed image of each page of the docu-
ment or Detail to see each page in a scrollable window.

Print Preview tab When you select the Print Preview tab you will be able to see what the report 
will look like. If there are multiple pages you can move forwards and backwards 
through them by clicking on the >> or << buttons.

Exporting your results
Hindsite allows you to export your data from a drive test results file in three 
different formats. To export the data you must first create a table view 
containing the data and then export it from there. The procedure is:

1 Open the drive test results file.

2 Add a table view containing the data that you want to export.

3 Right-click on the table view and select Export from the submenu.

Exporting in delimited
ASCII format

Selecting ASCII format will show the following dialog.
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Section of Route… – Complete table

Choose this option to export all the data rows in the table.

– Selected part(s) of table only

Choose this option to export the selected row(s) only.

File name Enter the name required for the file. To find an existing location, click Browse.

Browse Shows a file open dialog to let you choose the destination of the file.

Include headers The column titles will be included as the first row exported if this box is checked.

Delimiter The character inserted between the cell values is specified here. You should 
choose the character to suit the application program that you will use to read 
the file. 

Take care with the use of the comma character as a separator since this is used 
to indicate the position of the decimal point in some countries. This might mean 
that, when the file is read, the data is confused.

Exporting in PXF format PXF (Planning eXchange Format) is suitable for use with some planning tools. It 
is similar to AXF format but with some variations.

Selecting PXF will show a Save File As dialog. Specify the name of the file to be 
output. 

A progress bar will be shown as the file is written.
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Exporting in Planet format Planet format is suitable for use with the Planet planning tool from MSI. 

Selecting Planet will show a Save File As dialog. Specify the name of the file to 
be output. Two files will be produced with the same name but different exten-
sions.

A progress bar will be shown as the files are produced.

Exporting in Signia format Signia format is suitable for use with the Aircom Asset planning tool. 

Selecting Signia will show a Save File As dialog. Specify the name of the file to 
be output.

If there are multiple frequencies then a second dialog will appear asking you to 
select the frequency to be exported.

Two files will be produced with the same name but different extensions.

A progress bar will be shown as the files are produced.

Changing the coordinate system
Hindsite allows the user to convert between WGS-84 (longitude/latitude) in 
degrees, WGS-84 (longitude/latitude) decimal and local (easting/northing) coor-
dinate systems. This can then be exported to other software packages.

Hindsite records navigational data in longitude/latitude and by default displays 
all views in this form.

It is possible to show easting/northing during a run; however, this is not advis-
able as it can cause errors on lower specification systems.

Changing the coordinate
system

1 Open a run file that has navigational data.

2 On the icon toolbar, push the coordinate system icon .
A pull-down menu appears with three options: WGS-84 (Lat/Long), WGS-84 
(Lat/Long) Decimal and Local (Easting/Northing). The name with the tick on 
the left-hand side is the current coordinate system.
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3 Select an option. 
All table and map views will be updated automatically. This can take up to a 
few minutes depending on the size of the run file.

Managing Hindsite

Working folders The working folders are the default folders to hold your configuration and run 
(drive test result) files and your maps. You can change the default folders at any 
time, or simply select a different folder when you open or save a file.

Willtek recommends that you use folders to group your configurations and drive 
test result files into campaigns. This will make it easier for you to move the files 
between PCs and to back them up. The folders could be subfolders of the main 
working folders or completely separate ones.

The map folder must be set to the folder containing the correct maps before you 
open a configuration or drive test results file that needs to use the maps.

To change the default folders select Tools > Working Folders and then browse 
or type the paths to the folders.

Customizing the toolbars To customize the Hindsite toolbar choose Toolbars from the view menu. You can 
then tick or untick any of the sets of tools that are available at that time. Tools 
that are not ticked will not be shown on the toolbar.

You can move each of the sets of tools to dock on any of the four edges of the 
Hindsite window or to float in the middle of the window. Simply drag the two 
vertical bars at the left of each set to wherever you want the tools to be.
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Chapter 5 Using Measuring Instruments

This chapter provides task-based instructions for using the Hindsite features. 
Topics discussed in this chapter are as follows:

– “Introduction” on page 46

– “Willtek 8100 GPR series” on page 46

– “Willtek Griffin series” on page 53

– “Wheel calibrator wizard” on page 65
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Introduction
The present release of Hindsite is able to work with the Willtek GPR series of 
receivers, with or without the GPR Down Converter (1700 to 2500 MHz), and the 
Willtek Griffin series of receivers.

Willtek 8100 GPR series
Hindsite is able to work with the Willtek GPR series of precision receivers. There 
is a number of models in the range with differing characteristics and frequency 
coverage. 

This chapter details the use of the controls and facilities provided by Hindsite. 
Refer to the GPR manual for details of connecting the receivers, charging 
batteries etc.

General tab

GPR Model Select, from the drop-down list, the model of GPR that is to be used. It is impor-
tant that this is correct as the model affects the settings that are available. If you 
choose the wrong model you will not be able to start the drive test until you 
choose the correct one.

GFC Selected Check this box if the Willtek 8181 GPR Down Converter (1700 to 2500 MHz) is 
fitted to the GPR. 
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Bandwidth When the model has been correctly specified, select the required IF bandwidth 
from the drop-down.

Level Unit Select the required units for measurements from the drop-down.

Audio Filter On Check this box if the audio filter is to be switched on.

GPR Name You may specify here your own name for this instrument. This could, for example, 
be used to record its serial number or some identifying characteristic such as 
'Mary's one'.

Acquisition tab

Sample Mode Select either Single or Multiple sampling mode. In Single sampling mode, a list 
of frequencies is specified which will be cycled through during a run. In Multiple 
sampling mode, a single frequency is specified which will be sampled continu-
ously.

Depending upon which option is selected, the Sample tab is configured suitably.

Record Distance Check this box if you wish to record distance during the run.

Record Time Check this box if you wish to record elapsed time during the run.

Request by… You may specify the gap between measurements in a number of ways.
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Time

If you wish to specify the measurement gap in terms of time, select this option 
and specify the time interval in seconds.

Sample Gap

If you wish to specify the measurement gap in terms of distance, select this 
option and specify the distance interval in meters. 

Wavelengths

If you wish to specify the measurement gap in wavelengths (multiple sampling 
only), select this option and specify the integral number of wavelengths. This will 
be translated into a distance according to the frequency selected on the Multiple 
Sample tab.

Multiple Samples tab This will be available if multiple sampling has been selected on the Acquisition 
tab.

Frequency… Specify the RF frequency in MHz to be sampled. To adjust the value you may use 
the up/down arrows beside it. The amount by which the value will be adjusted is 
the current value in the Step box.

Step kHz

Specifies the amount (in kHz) by which the frequency will be adjusted when the 
up/down arrows are operated.
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Antenna Factor

If you wish to apply an antenna factor to the measurements, check the box and 
select the required antenna factor. The units of measurement will be changed to 
include 'per metre'. 

Cable Loss dB

If you wish to specify a loss for the cable connecting the antenna to the GPR, 
check the box and specify its value in dB. This value will be added to all readings 
from the GPR to correct the readings for the loss.

Unit

This will display the units of measurement. This is derived from the units speci-
fied on the General tab and whether an antenna factor has been specified on this 
tab.

Percentage Values If you want percentage values to be recorded, check the box and specify up to 
10 percentage values here. They should be entered in ascending order and can 
range from 1% to 99% in steps of 1%.

Add

If you wish to add a percentage to the list, specify its value in the box and click 
Add. 

Remove

If you wish to remove a percentage from the list, select it in the list and click 
Remove.

Confidence Values If you want confidence values to be recorded, check the box and specify up to 
10 confidence values here. They should be entered in ascending order.

Add

If you wish to add a confidence value to the list, specify its value in the box and 
click Add. 

Remove

If you wish to remove a confidence value from the list, select it in the list and 
click Remove.

Single Sample tab This will be available if single sampling has been selected on the Acquisition tab.
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Frequency List… You may specify here a list of one to ten frequencies that are cycled around 
during a measurement run. To add to the list, specify a frequency, antenna factor 
and cable loss as required and click Add. To remove an item from the list, select 
it in the list and click Remove.

MHz

Specify a frequency in MHz to be added to the list. To adjust the value you may 
use the up/down arrows beside it. The amount by which the value will be 
adjusted is the current value in the Step box.

Step kHz

Specifies the amount (in kHz) by which the frequency will be adjusted when the 
up/down arrows are operated.

Antenna Factor

If you wish to apply an antenna factor to the measurements, check the box and 
select the required antenna factor. The units of measurement will be changed to 
include 'per metre'. 

Cable Loss dB

If you wish to specify a loss for the cable connecting the antenna to the GPR, 
check the box and specify its value in dB. This value will be added to all readings 
from the GPR to correct for the loss.

Unit

This will display the units of measurement. This is derived from the units speci-
fied on the General tab and whether an antenna factor has been specified on this 
tab.
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Add

Click this to add an entered frequency to the list.

Remove

Click this to remove a selected frequency from the list.

Communication tab You must set the appropriate parameters to communicate with the GPR. See 
“Communications settings” on page 15 and refer to the GPR manual for allow-
able settings.

The default settings, achieved when the GPR is reset, are 9600 baud, parity 
disabled, two stop bits and 8-bit data. If you have changed the baud rate, parity 
and stop bits the changes will be recorded in the GPR and will remain while the 
receiver is switched OFF. You will need to set the corresponding parameters in 
Hindsite to communicate with the GPR. If you have difficulty establishing 
communications, try resetting the GPR and using the default settings.

Distance Transducer tab

If measurement gaps are expressed in terms of distance, the vehicle to be used 
must be calibrated. The distance transducer that will be attached to the wheel 
during a run issues a number of pulses for every revolution of the wheel. The 
circumference of the wheel will affect the number of pulses reported to Hindsite 
for each meter travelled. To allow Hindsite to work in meters, a calibration must 
be chosen from a prepared set or a new one must be created.

You must connect the wheel transducer to the parallel port of the PC via a 
Willtek PPA 9306 before you can calibrate or use the wheel transducer.
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Calibration… Re-Calibrate…

A vehicle should be recalibrated at regular intervals to cater for wear on the tyre 
and to check the distance transducer. Select the vehicle from the drop-down and 
click Re-Calibrate. The wheel calibrator wizard will be displayed. The new 
results will overwrite the old ones. See page 65 for details of using the wheel 
calibrator wizard.

Add Calibration…

To add a new vehicle to the set, click this button. The wheel calibrator wizard 
(below) will be displayed.

Remove

If you no longer require the calibration details of a vehicle, select it from the 
drop-down and click Remove.

Test

If you wish to check a vehicle calibration, select it from the drop-down and click 
Test. Hindsite will then show you a small dialog box listing the number of pulses 
seen, the distance travelled and the speed in meters per second. Click on the Go 
button to start the test. The parameters will update as you travel. Check that the 
distance travelled is correct and then click on Stop followed by Exit to end the 
test.

Port… LPT1/LPT2

Select the parallel port to which the distance transducer is attached via a 
PPA 9306.



Chapter 5 Using Measuring Instruments
Willtek Griffin series

Willtek 8010 HindsiteTM RF Propagation Test Software Version 2.20 53

Willtek Griffin series

Introduction Hindsite is able to work with the 8300 Griffin series of precision receivers. There 
are two models in the range, the 8301 (formerly SMR 9010) operating from 
800 MHz to 1000 MHz, and the 8302 (formerly SMR 9020) operating from 
1700 MHz to 2000 MHz. Converters are available for the 8301 to operate in the 
300 to 500 MHz and 2000 to 2200 MHz bands as well.

This chapter details the use of the controls and facilities provided by Hindsite. 
Refer to the Griffin manual for details of connecting the receivers, charging 
batteries etc.

The Willtek 8301 Griffin (or the SMR 9010) can also be used with an external 
converter, either the 8381 Griffin UMTS Down Converter (formerly GFC 4950) or 
the 8382 Griffin Up-Converter.

General tab The General tab carries settings for the receiver.
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Griffin Model Choose the model you will be using from the drop-down list. This will affect the 
frequencies that you can enter in the other tabs. If you choose the 8301 
(SMR 9010) you should also indicate whether you will be using a converter (8381 
Griffin UMTS Down Converter or 8382 Griffin Up-Converter). The frequencies 
allowed will depend on this choice (800 to 1000 MHz if no converter attached, 
2000 to 2200 MHz if 8381 UMTS Down Converter attached, or 300 to 500 MHz 
if 8382 Up-Converter attached). 

Converter file You can choose here the file of correction factors that applies to the converter 
being used (8381 Griffin UMTS Down Converter or 8382 Griffin Up-Converter). 
The converter file is supplied with the instrument on a floppy disk. It must be 
copied into the ‘GFC Corrections’ subfolder of the Hindsite installation folder to 
be used.

A dropdown list is given containing all files with a ‘.gfc’ extension found in the 
‘GFC Corrections’ folder.

Alternatively, if not specified here, you may choose it at run time.

Choose Antenna You can choose to use a file of antenna factors to convert the receiver readings 
from power (dBm or dBµV) to field strength (dBm/m or dBµV/m).

See “Antenna Factor Files” on page 111 for details of creating the antenna factor 
file.

IF Bandwidth (kHz) This allows you to set the IF bandwidth of the Griffin to either 200 kHz for GSM 
measurements or 15 kHz for CW measurements.

Input Attenuator This allows you to set a fixed attenuator rather than allow the Griffin to select 
the attenuator itself. You should choose the largest attenuator setting that is 
suitable for the expected range of signals. The setting of Hi Gain uses the 0 dB 
attenuator with an additional IF amplifier. This is most useful when measuring 
very low level signals with the 15 kHz IF bandwidth. The ranges of signals that 
can be measured are as follows:

– 30 dB: 0 dBm to –80 dBm

– 20 dB: –10 dBm to –90 dBm

– 10 dB: –20 dBm to –100 dBm

– 0 dB: –30 dBm to –110 dBm

– Hi Gain: –45 dBm to –125 dBm

Distance Unit You can choose to work in either meters or cm units. This setting affects the units 
of all the distances you can enter on the Acquisition tab.

Time Unit You can choose to work in either seconds or milliseconds. This setting affects the 
units of all the times you can enter on the Acquisition tab.
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Level Unit You can choose to work in either dBm or dBµV units. This setting affects the units 
of all the levels you can enter on the Acquisition tab as well as the units 
displayed on graphs and in tables.

Noise Filter On This section of the dialog box allows you to enable or disable the noise filter. 
Refer to the Griffin manual for a discussion about using the noise filter.

Self Correct When Starting When you select this check box Hindsite will instruct the Griffin to perform a 
self-correction process at the start of every drive test. The Griffins feature 
sophisticated algorithms to correct for most imperfections in the receiver. To 
provide optimum accuracy over variations in temperature and over the extended 
period between calibrations, the receiver contains a built-in reference source. To 
get the best precision from the receiver you should enable the ‘Self-Correct 
When Starting’ check box. 

Note that the self-correction process takes 20 seconds so you should press the 
Start button before you get to the actual place where you want to start the drive 
test.

It is not necessary to do the self-correction to make measurements but the 
receiver is only guaranteed to be within specification after the self-correction 
measurements are made.

It is best to remove the antenna from the receiver while doing the self-correction 
measurements to avoid a strong signal from interfering with them.

The results of the self-correction measurements are kept until the receiver is 
switched off or reset. Simply changing the measurement mode or settings will 
not lose them. 

Griffin Name You can give the Griffin a name to identify it. You could, for example, use it to 
record the serial number of the Griffin. The Griffin name is used in the 
Configuration > Edit menu (before starting a test), and in the Configuration 
> View menu (after loading a *.RUN file containing measurement results). It is 
also stored when exporting the configuration.

Unit Information Click on the Unit Information button to bring up a form showing information 
on the Griffin connected. This is gathered by Hindsite from the Griffin and 
includes such things as its serial number etc.

Advanced… To specify advanced settings, click Advanced. The following dialog will be 
shown.
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Reference Connector…

The Griffin has an internal precision 10 MHz crystal reference which is used to 
tune the receiver. You can use this reference as an output from the receiver to 
ensure that other equipment is tuned to precisely the same frequency. Alterna-
tively you can connect your own 10 MHz reference to the receiver which will 
then use it instead of the internal one. The reference needs CMOS/TTL levels and 
is AC-coupled within the Griffin.

To enable the reference output click on Output. 

To use an external reference, first select Input, then connect a low-noise CMOS/
TTL level reference to the reference input. If the Griffin is not able to use the 
external reference for any reason you will get ‘Synthesizer out of Lock’ messages.

In normal operation leave the Reference Connector set to Unused.

IF Outputs Enabled

To turn on the two IF outputs check this box. Leaving them off saves power when 
operating from batteries.

The outputs are the in-phase and quadrature components of an image reject 
mixer at 10.7 MHz. The effective bandwidth is far wider than the 15 or 200 kHz 
IF filters. To use these apply to Willtek for technical details of the circuitry neces-
sary.

Distance Calibration tab If measurement gaps are expressed in terms of distance, the vehicle to be used 
must be calibrated. The distance transducer that will be attached to the wheel 
during a run issues a number of pulses for every revolution of the wheel. The 
number of pulses reported to Hindsite will represent an actual distance only if 
the circumference of the wheel is known.
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To this end, a calibration must be chosen from a prepared set or a new one must 
be created.

The distance transducer should be connected to the Wheel Enc. input of the 
Griffin. 

Calibration… Re-Calibrate…

A vehicle should be recalibrated at regular intervals to cater for wear on the tyre. 
Select the vehicle from the drop-down and click Re-Calibrate. The calibration 
wizard will be displayed. The new results will overwrite the old ones. See page 65 
for details of using the wheel calibrator wizard.

Add Calibration…

To add a new vehicle to the set, click this button. The calibration wizard (see 
page 65) will be displayed.

Remove

If you no longer require the calibration details of a vehicle, select it from the 
drop-down and click Remove.

Test

If you wish to check a vehicle calibration, select it from the drop-down and click 
Test. Hindsite will then show you a small dialog box listing the number of pulses 
seen, the distance travelled and the speed in meters per second. Click on the Go 
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button to start the test. The parameters will update as you travel. Check that the 
distance travelled is correct and then click on Stop followed by Exit to end the 
test.

Communication tab Refer to “Communications settings” on page 15 for a detailed discussion on this 
tab. You should make the settings as detailed below.

Griffin Communications
Settings

Port

Select the COM port that you are going to use for the Griffin.

Baud Rate

The Griffin can operate from 2400 to 57,600 baud and you must set this to match 
the setting in the Griffin. Willtek recommends that you use the highest baud rate 
that your PC can support. Refer to the Griffin User Manual for instructions on 
setting the Griffin baud rate.

Data Bits

This must be set to 8.

Parity

This will usually be set to none, but the parity can be changed in the Griffin to 
odd, even or none. 

Stop Bits

This must be set to 1.

Carrier Detect This should be disabled. 

Frequency List tab This tab allows you to enter the frequencies upon which to measure. Currently 
Hindsite only supports the cycling mode in the Griffins. To perform a scan you 
should use the cycling mode with equally-spaced frequencies. To measure on just 
one frequency you should cycle on one frequency.
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The Griffin’s 150 memories are programmed with different frequencies. The 
Griffin goes through its memories making the same Measurement on each 
frequency. Unlike scanning mode, the frequencies can be at any spacing and in 
any order. This is most useful for measuring on specific frequencies.

You must enter the list of frequencies in the order they are to be measured.

A list of frequencies round which the Griffin will cycle are specified here. The 
frequencies may be specified individually with Insert, Modify and Delete or a 
series of frequencies may be specified with Fill.

Insert To insert a frequency in the list, enter the value in the box (in MHz) and click 
Insert. The new value will be inserted in the list.

Modify To change the value of a frequency in the list, select the frequency in the list (its 
value will appear in the box), amend the value and click Modify. The value of the 
selected frequency will be changed.

Delete To delete a frequency from the list, select the frequency in the list and click 
Delete. The frequency will be removed.

Clear To remove all frequencies from the list, click Clear.
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Fill… To scan across frequencies you should create a list with a series of equally-
spaced frequencies. To do so click Fill. The following dialog will be shown.

Low Frequency

Enter the start frequency of the series.

High Frequency

Enter the end frequency of the series.

Frequency Step

Enter the increment to be applied to the series.

Number of Steps

The number of frequencies in the series is shown as each of the above three 
values is entered. This must be less than the 150 memories available in the 
Griffin. 

To finish

When the values have been entered, click OK. The series will be entered into the 
frequency list on the main editor tab.

Acquisition tab The Acquisition tab allows you to control the way that the Griffin makes the 
measurements. The Griffin offers great flexibility in its measurements so 
choosing the best settings for any particular measurement can be confusing at 
first. Refer to “Applications of the Griffin” on page 105 for a discussion on setting 
these parameters.
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Measurement Mode This allows you to choose what type of measurement the Griffin is to make.

Single

In Single mode a single sample is taken for each measurement. This is the fastest 
mode and allows up to 1000 frequencies to be measured per second.

Willtek recommends that you select time sampling at the 100 kHz rate when in 
single mode.

Min

The level measured is the minimum observed over the measurement period. This 
mode is particularly useful where you need to know that a minimum acceptable 
level is maintained. It can also be used to indicate the range of variation of a 
signal.

Mean

The level measured is the mean of all levels observed over the measurement 
period. This has the effect of filtering the signal to reduce sample to sample vari-
ations.

Max

The level measured is the maximum observed over the measurement period. This 
is most useful to indicate the range of variation of a signal over a period. 
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Histogram

The Griffin calculates a histogram from the observed levels. The histogram has a 
count for each dB value in its range, for example a count for –56 dBm, another 
for –57 dBm etc. Hindsite uses the histogram counts to calculate percentage 
values such as 10%, 50% and 90% values.

Autoranging is disabled during histogram measurements.

The minimum measurement period is 50 ms. You must ensure that the number 
of samples times the sample period (1/sample rate) is greater than 50 ms.

Sampling This controls how the Griffin samples the signal. You can choose whether to 
sample with equal times between samples or equal distances.

Number of Samples

Sets the number of samples to be used for mean, max, min or histogram 
measurements. You can use up to 65,535 samples. If you choose Single Measure-
ment the number of samples will, of course, be 1.

Sample Rate

This is only available if you have chosen time sampling. You can set the sampling 
rate used by the Griffin. The maximum rate for mean measurements is 100 kHz, 
and 50 kHz for other measurements. You can use this to space the samples 
further apart in time.

Triggering This controls when the Griffin starts a measurement. The Griffin allows you to 
use distance or time to control the instant when it starts a measurement of the 
RF signal. This is called triggering as each measurement is triggered to start. 
Whether to use distance or time for the triggering depends on the type of 
measurement you are doing.

The Griffins do not measure continuously, they must be triggered to start a 
measurement. Once triggered the measurement will be completed and, at the 
end of the measurement, the Griffin will retune to the next frequency. It will then 
wait for a trigger to start the measurement on the new frequency. Thus when 
you set the triggering you are controlling when the Griffin will change frequency 
and this is why it is called the 'frequency spacing'.

Make sure that you are clear about the difference between triggering and 
sampling. Perhaps an example will help; you might choose to do a mean 
measurement where each measurement consists of 1000 samples. You might 
then choose to trigger the start of each measurement every time you have trav-
elled 10 m along the road.

Frequency Spacing

The frequency spacing is the interval between triggers. You must choose this to 
be greater than the time taken to make the measurement or else the Griffin 
cannot complete one measurement before being triggered to start the next.
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There is sometimes confusion over the meaning of frequency spacing. It is the 
spacing between frequency changes, not between the start of a cycle. Thus if you 
decide to cycle around five frequencies with a frequency spacing of 1 m, the 
cycle will take a total of 5 m to complete.

The maximum values that you can set depend on whether you have chosen time 
or distance triggering. In either case the maximum is set by the counter in the 
Griffin, which has a maximum value of 65,535 counts.

In time sampling and triggering the sample rate affects the total period available 
to you. Thus, if you choose a sample rate of 100 kHz each pulse lasts 10 µs so 
65,535 pulses last 655.35 ms, which is the maximum you can set. If you choose 
a sample rate of 50 kHz each pulse lasts 20 µs so the maximum is about 
1300 ms.

In distance sampling and triggering the sample spacing affects the total distance 
available to you. If you choose a sample spacing of 10 cm a divider in the Griffin 
is set to give one pulse output every 10 cm. (This is not precise, see “Applications 
of the Griffin” on page 105 for a discussion of some of the issues). The trigger 
divider is then working in units of 10 cm so 65,535 pulses cover 6.553 km, which 
is the maximum you can set.

Spectrum Analyser tab The Spectrum Analyser tab allows you to use the Griffin as a spectrum analyzer 
to survey the RF environment in which you are about to work.
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Minimum Frequency

Enter the start frequency of the sweep.

Maximum Frequency

Enter the end frequency of the sweep.

Frequency Step

Enter the increment to be used for the sweep.

Sweep Time

Enter the total time the sweep is to take. This will be used to set the amount of 
time the Griffin spends on each frequency. Remember that the Griffin can scan 
up to 1000 frequencies per second and your setting must allow sufficient time 
for the Griffin to scan. If you use times longer than the minimum possible the 
readings at each frequency will be averaged to reduce their noise.
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Wheel calibrator wizard
The wizard takes you through the steps to make a calibration. You will be 
required to drive a significant, measurable distance whilst the wizard is in moni-
toring mode. You can measure the distance with the odometer in your car or, for 
better accuracy, you can use two points a known distance apart.

Before you start, ensure that the distance transducer is properly connected to 
your PC via a suitable interface and then start driving.

Start When you are ready to start the calibration, click Start. The next page of the 
wizard will be displayed.

Drive a measurable distance. For more reliable results do not drive too fast.

Pulses This will display the number of pulses being monitored as you drive.
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Finish When you have completed the measured distance, click Finish. The next page of 
the wizard will be displayed.

Enter the distance you travelled as accurately as possible and select the correct 
units (miles, yards or kilometers) from the drop-down list.

Choose a name under which to save the calibration details. Willtek recommends 
that you include a reference to the vehicle such as its registration (licence plate) 
number.
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Chapter 6 Managing Views

This chapter describes the different result views and their options. Sections 
described in this chapter are as follows: 

– “Introduction” on page 68

– “Linking between views” on page 68

– “Table view” on page 68

– “Graph view” on page 71

– “Map view” on page 78
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Introduction
Hindsite shows the data to you through views. There are currently three views 
available in Hindsite, graph, table and map views. You can open as many views 
as will fit onto your screen at the same time and you can customize each one 
separately.

Linking between views
Map and graph views can be linked so that they show data from the same section 
of a route. When they are linked, if you change one of them the change is 
reflected in the others. For example, if you zoom in on the graph, a linked map 
will show the change in the section of the route by moving its route markers.

The route markers on a map appear as green bullets, one at each end of the 
section of the route. The route between the route markers (called a route section) 
will be shown in its normal colors and the sections outside of the route markers 
will be in pale yellow.

To move a route marker on a map click on the marker and it will change to a pin. 
Move the pin to where you want the route marker and then click again to place 
it. Any linked graphs will then update to show only the new section of the route.

You can link or unlink views by choosing View > Presentation > Route Section 
Linkage and then ticking or unticking the views that you wish to link. When you 
add a new view to a presentation it will be linked by default.

Table view
The table view consists of one or more columns of data that can be derived from 
any instrument used during the drive test.

Live data If it is being viewed during a drive test, data is added to the bottom of the table, 
as it becomes available, and the last row of the table is kept visible. You can use 
the scroll bar on the right of the table to look at earlier data. If you do so that 
part of the data is kept visible and you cannot see the new, live, data being added. 
To restore the action of keeping the last row in view, scroll the table to the 
bottom.

Exporting data The table view is used to export data. Refer to page 40 for details on the export 
facilities.
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Copying data from a table
view

If you wish to copy displayed data from the table to the Windows clipboard, 
select the rows you want to copy (the whole table is copied if no rows are 
selected). Right-click the table and select Copy from the submenu. You can then 
change to another Windows application and paste the data into it.

Using the table view editor The table editor may be displayed by selecting the View/Presentation/Edit View 
menu and selecting View from the submenu.

Alternatively, you can right-click the mouse on the table view and then select the 
Properties menu item.

Column

The column that was right-clicked will be displayed, but others may be selected 
by means of the left/right arrows beside the column number.

Insert

To insert a column, click Insert. A blank column will be inserted before the 
selected column.

Remove

To remove the selected column, click Remove.
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Column Title

A default title for the selected column will be displayed, dependent upon the 
data being displayed, but you may specify any other title. Be careful not to 
confuse other people by using a title that does not accurately reflect the data in 
the column.

Field

The data (or 'field') to be displayed in a column may be specified here. In the 
drop-down, all available data is shown (with its source instrument or analysis).

To limit the drop-down to a particular source of data, select that source from the 
data source drop-down (below). 

Analysis

This is not available in this release of Hindsite.

Unit

The units in which the data is to be displayed may be specified here. Note that, 
if these units are not the same as those used when the data was recorded, Hind-
site will have to convert them. On lower-performance PCs this might lead to a 
noticeable degradation in performance.

Data Source

When selecting the field (above), the choice may be limited to a particular source 
of data from this drop-down.

Number of decimal places

If the field chosen is nonintegral numeric field, you may specify the number of 
decimal places to be displayed.

Colouring

You may specify that data values in the column are displayed in particular colors 
according to the range in which the value falls. If the data is numeric, a minimum 
and maximum are specified. If the data is nonnumeric, discrete values will be 
specified.

A default range is always included which covers any value not otherwise speci-
fied.

Other ranges may be added and removed. You must ensure that the value you 
enter is a valid number and is within the expected range of signal strengths.

Note that, in a best server table, coloring is ignored and, within each row, the 
strongest signal(s) are colored red.

Add

To add a range, click Add and a blank row will be added to the table. Fill in the 
minimum and maximum of the range (or discrete value) and click the color you 
require from the palette.
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Remove

To remove a range, position the cursor in the row concerned and click Remove. 
You may not remove the default range.

Graph view
The graph view consists of one or more traces plotted against specific X and Y-
axes.

The X-axis value is that of a field that represents progress through the drive test 
(in other words, distance or time).

The Y-axis value is that of a field being measured. 

Viewing live data If live data is being viewed during a drive test, traces are extended to the right 
as data becomes available. The graph is scrolled to the left so that the current 
point is kept visible, unless the scroll bar is operated to bring another part of the 
graph into view, when that part is kept visible.

To restore the action of keeping the current point in view, the graph should be 
scrolled to the right.

Zooming the graph The graph may be zoomed in or out as required. All zoom-ins are remembered 
and may be undone.

Zooming in There are two methods of zooming in:

The incremental zoom-in button for the horizontal axis  and for the vertical 
axis . When you click on either button a zoom-in of 20% is performed on the 
current center.

The manual zoom-in: Hold the mouse button down, draw a rectangle around the 
area of the graph you want to zoom-in on and release the mouse button.

Zooming out There are two methods of zooming out:

Undo previous zoom-in button . When you click on this button the previous 
zoom-in is discarded and the one before it (if any) becomes the previous zoom-
in.

Full zoom-out button . Click on this button to discard all previous zooms show 
the graph to its full extent.

Panning the graph You can pan the graph in any orthogonal direction using the panning keys 
. The zoom factor is retained.
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Copying graph image to
clipboard

Select the Edit/Copy menu  to copy an image of the graph to the clipboard. 
You can subsequently paste the image into another Windows application.

Editing specific parts of
the graph

Also available from the View menu (and from the right-click menu) are specific 
parts of the overall editor. See the following section on the graph view editor for 
details of changing the graph.

Limit Displays the limit line editor from the Y-axis tab of the full editor.

X Axis Displays the (horizontal) X-axis tab from the full editor.

Y Axis Displays the (vertical) Y-axis tab from the full editor.

Traces Select, from submenu, the trace required, to display the trace editor from the 
traces tab of the full editor.

The legends for the traces may also be toggled here. 

Using the graph view
editor

The graph editor may be displayed by selecting the View > All Properties menu.

Alternatively, you can right-click the mouse on the graph view and then select 
the Properties menu item.

General tab This enables you to specify general characteristics of the graph view.
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Name

Enter a name for this graph if you require.

Colours…

The colors of the items below may be changed.

– Grid

The X/Y grid.

– Background

The background of the area within the axes.

– Text

The legend and titling of the graph.

– Frame

The background of the area outside the axes.

X-Axis tab This enables you to change the characteristics of the X-axis.
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Axis Title

You may enter your own axis title here. You can enter any text so take care not 
to confuse other people who might read it.

Text Colour

The color of the X-axis.

Range…

This specifies the visible range of the X-axis.

– Show All

Check this to show the complete drive test.

– Unit

Select the units to be used for the X-axis.

Grid

Check this box to show the X grid (vertical lines).
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Labels

Check this box to display X-axis tick mark annotations.

Show Markers

Check this box to show markers on the graph.

Field

The data (or 'field') to be displayed as the X-axis is shown here. It cannot be 
changed.  

Analysis

This is not available in this release of Hindsite.

Data Source

The data source for the field is shown here. It cannot be changed.

Y-Axis tab

Axis Title

You may enter your own axis title here.
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Text Colour

The color of the Y-axis.

Range…

You may specify here the extent of the Y-axis.

– Auto

Check this box if autoranging is required.

– Start

If not autoranging, this specifies the value of the Y-axis at the origin of the 
graph.

– Extent

If not autoranging, this specifies the value of the extent of the Y-axis (start + 
extent = top of graph).

– Unit

This specifies the units to be used for the Y-axis.

Grid

Check this box to show the Y-axis grid (horizontal lines).

Labels

Check this box to show the Y-axis tick mark annotations.

Limit…

Hindsite allows you to put a limit line on the graph for reference purposes. You 
can specify its details here.

– Title

Enter the name to be shown against the limit line.

– Colour

Select the color of the limit line.

– Line Type

Select the type of line required for the limit line.

– Hide

Check this box if you want to hide the limit line, clear it to show the limit line.

– Value

The value at which the limit line will be drawn.
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Traces tab In this tab, you can customize each trace individually. The top of the tab is used 
to select traces and insert and remove them as required.

Once a trace is selected, the lower part of the tab applies to that trace.

Trace

Either enter a trace number or use the left/right control to select one.

Insert

Click this button to insert a new trace, then complete the details of the trace in 
the lower part of the tab.

Remove

Click this button to remove the currently selected trace.

Title

Enter the name to be given to the trace. You can enter any text so take care not 
to confuse other people who might read it.

Colour

Select the color of the trace.
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Line Type

Select the line type of the trace.

Hide

Check this box to hide the trace.

Field

The data (or 'field') to be displayed as the Y-axis may be specified here. In the 
drop-down list, all available data that is suitable is shown (with its source instru-
ment or analysis).

To limit the drop-down list to a particular source of data, select that source from 
the Data Source drop-down (below). 

Analysis

This is not available in this release of Hindsite.

Unit

The units in which the data is to be displayed may be specified here. Note that, 
if these units are not the same as those used when the data was recorded, 
conversion will have to be done with possible degradation in performance. 

Data Source

When selecting the Field (above), the choice may be limited to a particular source 
of data from this drop-down.

Map view
The map view consists of a raster or vector map upon which is superimposed the 
route of the drive test. The route may be drawn in either monochrome or in colors 
where each color represents a different range of the data.

The map view can be made into a background view. This will occupy the whole 
of the Hindsite window but will always be behind other views, that is, all other 
views will appear on top of it. Only one view may be a background view at one 
time.

Map tiles Maps are generally supplied in tiles of convenient sizes. Hindsite will join adja-
cent tiles together seamlessly to create one large map. If you do not have all of 
the tiles to cover the area where you are working, Hindsite will fill the gaps with 
a white background.

Note

Maps are only provided with Hindsite for demonstration purposes. You must 
provide your own maps to cover the area of your survey for Hindsite to use.
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Hint: If you do not have any maps for the area where you are working, you can 
use the demo map tile shipped with Hindsite. You will only get a white back-
ground but you will be able to see the general shape of the route that you drive.

Zooming the map The map may be zoomed in or out as required. Hindsite limits the amount that 
you can zoom in so that the map represents a distance of at least 1.5 meters 
wide.

Zooming in There are two methods of zooming in:

The View/Zoom In menu or button . A zoom-in of 20% is performed on the 
current center.

The manual zoom-in: Hold down the left mouse button, draw a rectangle around 
the area of the map you want to zoom-in on and release the mouse button.

Note that, if using a raster map, you may zoom in too far for any details of the 
map to be displayable and the background will be shown white. If this happens, 
zoom out until the map reappears.

Zooming out There are two methods of zooming out:

The View > Zoom Out menu or button . A zoom-out equivalent to an incre-
mental zoom-in of 20% is performed.

The View > Show Whole Route menu or button . The map is adjusted to 
show the whole route with a margin around it.

Panning the map You can pan the graph in any direction using the panning button:

1 Push the panning key (hand icon) . The mouse pointer will turn into a 
hand symbol when placed on the map view.

2 Click on the map, hold the mouse key and drag the map to a new position.

3 When the map shows the desired view, push the panning key  again. This 
will turn off the panning function.

Changing the plot type The plot may be monochrome or color-coded and it may be annotated or not.

Monochrome/color-coded plots The View > Plot Type > Colour menu  is a toggle. When on, the route is 
shown color-coded according to the current ranges. When off, the route is 
shown in the current default color.
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Annotated route plots The View > Plot Type > Annotated menu  is a toggle. When on, the route is 
annotated with values. As many nonoverlapping annotations as possible are 
shown. All values are signed: the center of the sign indicates the precise point to 
which the value applies.

Determining position on
map

Whenever the mouse pointer is over the map, a display of its position in map 
terms (either longitude/latitude or easting/northing) is maintained in the status 
bar at the bottom of the map view. Easting and northing is shown for files 
imported from FSS, while latitude and longitude is shown for other files. 

Determining the value at a
point

When you hover the mouse pointer over a point on the route, its value will be 
displayed after a small pause.

If the map is showing signal strengths, the signal strength at that point will be 
shown. If the map is showing best server, the frequency of the best server is 
shown.

Setting the map as
background

The View > Background menu or button  is a toggle. When it is on, the map 
will become full size within the Hindsite window and all other views will appear 
on top of it. When it is off, the map view behaves like any other view and can be 
moved and resized.

Setting grid size The Edit > Grid menu is a toggle. To switch on an annotated coordinate grid, 
select a size from the submenu. To switch it off, select (None).

Using the map view editor The map view may be edited by selecting the View > Properties menu or by 
right-clicking on the map and selecting Properties from the menu.
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Route tab

Line Width

The width of the route line (in pixels) may be specified here. It must be in the 
range 1 to 7. The box beside the value shows a line of that width.

Ranges

The coloring of the line in a multicolored signal strength route plot may be spec-
ified here. If the value of signal strength is within one of the specified ranges, 
the line has that color at that point. If the value does not lie within any of the 
specified ranges, it adopts the default color.

Ranges may be inserted, modified and deleted. The default range may not be 
deleted.

To modify a value, select it and overtype it.

You must ensure that the value is a valid number and is within the expected 
range of signal strengths.

– Add

To insert a range, click the Add button. A blank row will be added to the bottom. 
Complete the row with minimum and maximum values and click the color 
required for the range.
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– Load/Save

To save the current set of ranges and colors or load a previous presentation click 
this button. Another dialog box will open.

All presentations are saved in the Windows registry. If saving a presentation 
either type a new name into the box or select a previously saved one from the 
drop-down list and click Save. If you wish to load a presentation select the name 
from the drop-down list and press Load.

– Remove

To remove a range, select the range in the table and click Remove.

– Frequency List

This is only available in the best server and composite coverage map.

The frequency list box contains the frequencies that are being analyzed in the 
current map view.

– Remove Frequency

This is only available in the best server and composite coverage map.

To remove a frequency from the current map view, select the frequency you wish 
to remove by selecting it from the frequency list box and then click Remove. 

Field

The data (or 'field') to be displayed may be specified here. In the drop-down, all 
available data that is suitable is shown (with its source instrument or analysis).

To limit the drop-down to a particular source of data, select that source from the 
data source drop-down list (below). 

Analysis

This is not available in this release of Hindsite.

Note

The presentation does not store the level units, so make sure the correct level 
unit is set before loading the presentation.
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Unit

The units in which the data is to be displayed may be specified here. Note that, 
if these units are not the same as those used when the data was recorded, Hind-
site will have to convert them. On lower-performance PCs this might lead to a 
noticeable degradation in performance.

Data Source

When selecting the field (above), the choice may be limited to a particular source 
of data from this drop-down list.

Printing the map There are three ways to print the map – as a screen image (File > Print Screen), 
as part of a report (File > Print) or as a scaled print. Refer to page 39 for details 
of printing the map as a screen image or report.

To print the map and route as a scaled print on a single sheet of paper, right-click 
the map and select Print… from the menu. 

Printer Choose which printer to use and then, if necessary, adjust its properties by 
clicking on the Properties button.

Extent You can choose either to print the map as visible on the screen (which might be 
zoomed onto a small region) or a map that covers the whole of the drive test 
route.

Content If you untick the Background Map box then only the route will be printed.
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Scale and Pages You can choose either a fixed scale for the map (when Hindsite will decide on 
the number of pages needed) or the number of pages (when Hindsite will decide 
on the appropriate scale).
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Chapter 7 Hindsite Fields

This chapter provides a detailed discussion of the various result fields available 
with the different instruments. Topics discussed in this chapter are as follows:

– “Introduction” on page 86

– “Calculated fields” on page 86

– “Making the right fields available” on page 89

– “Fields produced by measuring instruments” on page 89

– “Fields produced by navigation instruments” on page 92

– “Fields produced by other instruments” on page 93

– “Description of all fields” on page 94
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Introduction
A Hindsite field is a particular type of data, for example signal strength is a field, 
as is the 10% value. There are two types of field, those that are measured directly 
by the instruments and those that are calculated by Hindsite. There is, in most 
cases, little difference between them, however, you are able to change the 
parameters of some of the calculated fields. 

Some fields that are measured directly by one instrument might need to be 
calculated for another instrument. For example, the GPR produces percentage 
values directly whereas the Griffin produces histograms, which Hindsite must 
then analyze to derive the percentage values. Whether a particular field is calcu-
lated or produced directly by the instrument is sometimes confusing. 

Calculated fields

Carrier to Interference
Ratio field

The C/I field is calculated for all instruments. When you add a C/I field (or when 
you add a base view that contains a C/I field) you will be shown a dialog box to 
let you specify the calculation for the field.

A graph or table view can show several C/I ratios at the same time. You can select 
one of them to work with on the right of the dialog.

Hindsite creates the field name automatically to show how that field is calcu-
lated, for example the name 

'(c)93.4 / (I)98.2 @ (T)-9dB' 

means that the carrier is 93.4 MHz, the interferer is 98.2 MHz and the threshold 
is –9 dB. 



Chapter 7 Hindsite Fields
Calculated fields

Willtek 8010 HindsiteTM RF Propagation Test Software Version 2.20 87

You can change the name by typing a new name to replace the automatic one. 
To prevent Hindsite from replacing your name with another automatic one when 
the field is edited, check the Lock Name box.

To change any of the parameters for the current field, first choose the parameter 
from the list (carrier, interferer or threshold) and then choose the new value from 
the list below. This list will show only those frequencies which are available and 
thresholds from 0 to –20 dB with a default of –9 dB.

To add a new field click on the Add button and then edit the field as necessary.

Percentage field The percentage field is available for the Griffin instrument. It is calculated from 
a histogram measurement in the same way that the GPR calculates percentage 
values. When you add a percentage field to a view, you will have the option to 
select the percentage for which you want the value from the Analysis drop-down 
menu.

Hindsite creates the field name automatically to show how that field is calcu-
lated. You can change the name by typing a new name to replace the automatic 
one. To prevent Hindsite from replacing your name with another automatic one 
when the field is edited, check the Lock Name box.

To add a new field click on the Add button and then select the percentage you 
want from the drop-down list.

Confidence interval field The confidence interval field is available for the Griffin instrument. It is calcu-
lated from a histogram measurement in the same way that the GPR calculates 
confidence intervals. When you add a confidence interval field to a view, you will 
have the option to select the level for which you want the value from the Anal-
ysis drop-down menu.
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Hindsite creates the field name automatically to show how that field is calcu-
lated. You can change the name by typing a new name to replace the automatic 
one. To prevent Hindsite from replacing your name with another automatic one 
when the field is edited, check the Lock Name box.

To add a new field click on the Add button and then select the confidence 
interval you want from the drop-down list.

Average field The average field is available for the Griffin instrument. It is calculated as the 
average over a selectable number of measurements. When you add an average 
field to a view, you will have the option to select the number of measurements 
to average over (1 to 1000) from the Analysis drop-down menu.

Hindsite creates the field name automatically to show how that field is calcu-
lated. You can change the name by typing a new name to replace the automatic 
one. To prevent Hindsite from replacing your name with another automatic one 
when the field is edited, check the Lock Name box.
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To add a new field click on the Add button and then select the number of 
samples you want to average over from the drop-down list.

Making the right fields available
When you choose what data are to be shown by a view, you are actually choosing 
which fields to view. Hindsite will only allow you to choose the fields that will 
be available from the instrument settings that you have chosen. If a field is not 
available to you, it is because you did not choose the correct settings to produce 
the field. 

If you change the settings on an instrument to make a field available to a base 
view you must delete the base view and then reinsert it to make the new field 
available.

When Hindsite creates the base views for a configuration it analyzes the settings 
you have chosen for the instruments and puts the available fields into the base 
views. For example, if you have chosen to measure across multiple frequencies 
Hindsite will create one column for each frequency into a table view. 

Fields produced by measuring instruments
The following table lists all the fields that are produced by the GPR and Griffin 
measuring instruments. It also includes those fields that can be imported from 
files produced by the Willtek FSS field survey software using the GPR. Note that 
the fields available in any particular configuration or drive test will depend on 
the settings you chose for the instrument.

Table 1 Fields produced by measuring instruments

Field FSS GPR Griffin

Antenna names X

Average X

Bottom latitude X

Bottom northing X

Calibration X

Channel data AFD X

Channel data histogram X

Channel data LCR X

Channel data max X

Channel data mean X

Channel data min X

Channel data single X X X
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Channel data single max X

Channel data single min X

Confidence X X

Confidence names X

C to I X X

Date X

Datum easting X

Datum northing X

Distance X X X

Distance units X

Easting X

End X

Event X X X

Fix X

Frequency names X

Gain names X

Geodetic ellipsoid scale X

Geodetic X-offset X

Geodetic X-rotation X

Geodetic Y-offset X

Geodetic Y-rotation X

Geodetic Z-offset X

Geodetic Z-rotation X

GPR X

Latitude X

Left easting X

Left longitude X

Longitude X

Max confidence X X

Max percentage X

Max signal X

Min confidence X X

Min percentage X

Table 1 Fields produced by measuring instruments

Field FSS GPR Griffin
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Min signal X

Northing X

System time X X

Percent X X

Percentage names X

Position system X

Projection conversion X

Projection local easting X

Projection local northing X

Projection meridian X

Projection meridian scale X

Projection parallel X

Right easting X

Right longitude X

Run time X X X

Samples X X X

Scan data AFD X

Scan data LCR X

Scan data max X

Scan data mean X

Scan data min X

Scan data single X

Speed

Spheroid flattening X

Spheroid semi-major axis X

Spheroid semi-minor axis X

Start time X

Title X

Top latitude X

Top morthing X

Total datum X

Total distance X

Total rooms X

Table 1 Fields produced by measuring instruments

Field FSS GPR Griffin
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Fields produced by navigation instruments
The following table lists all the fields that are produced by the JRC and Trimble 
Navigation instruments. Note that some of the fields are optional and you can 
choose whether to include them in the instrument editor when you create the 
configuration.

Total waypoints X

Transport used X

Version X

Waypoint X

Waypoint suspect ID X

Waypoint type X

Table 1 Fields produced by measuring instruments

Field FSS GPR Griffin

Table 2 Fields produced by navigation instruments

Field JRC Trimble

Bottom latitude X X

Event X X

Fix X X

Heading X X

Height X X

Latitude X X

Left longitude X X

Longitude X X

System time X X

Right longitude X X

Speed X X

Top latitude X X

UTM X X
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Fields produced by other instruments
The following table lists all the fields that are produced by other 'instruments'. 
Although called instruments within Hindsite these are really parts of the Hindsite 
software that produce the fields rather than actual devices connected to the PC. 
Note that not all of the fields will be present in all drive tests. 

Table 3 Fields produced by other instruments

Field W/P

Corrected distance

Event X

Route trace bottom latitude

Route trace bottom north

Route trace easting

Route trace latitude

Route trace left easting

Route trace left longitude

Route trace longitude

Route trace northing

Route trace right easting

Route trace right longitude

Route trace top latitude

Route trace top northing

Route trace type

Waypoint X

Waypoint bottom Y X

Waypoint count X

Waypoint left X X

Waypoint notes X

Waypoint ordinal X

Waypoint right X X

Waypoint suspect ID X

Waypoint top Y X

Waypoint type X

Waypoint X X

Waypoint Y X
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Description of all fields
The following table lists all the fields that are known to Hindsite with a brief 
comment where appropriate.

Some of these fields are included for possible future releases of Hindsite. 

Table 4 Description of all fields

Field Comments

Antenna names Only from imported 
FSS files

Average Calculated

Bottom latitude

Bottom northing

Calibration

Channel data AFD Griffin

Channel data histogram Griffin

Channel data LCR Griffin

Channel data max Griffin

Channel data mean Griffin

Channel data min Griffin

Channel data single Griffin

Channel data single max Griffin

Channel data single min Griffin

Confidence

Confidence names

Corrected distance

C to I Calculated

Date

Datum easting

Datum northing

Distance

Distance units Always metric

Easting

End

Event

Fix
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Frequency names

Gain names

Geodetic ellipsoid scale

Geodetic X-offset

Geodetic X-rotation

Geodetic Y-offset

Geodetic Y-rotation

Geodetic Z-offset

Geodetic Z-rotation

GPR

Heading

Height

Latitude

Left easting

Left longitude

Longitude

Max confidence

Max percentage

Max signal

Min confidence

Min percentage

Min signal

Northing

System time

Percent

Percentage names

Position system

Projection conversion

Projection local easting

Projection local northing

Projection meridian

Projection meridian scale

Projection parallel

Right easting

Table 4 Description of all fields
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Right longitude

Route trace bottom latitude

Route trace bottom north

Route trace easting

Route trace latitude

Route trace left easting

Route trace left longitude

Route trace longitude

Route trace northing

Route trace right easting

Route trace right longitude

Route trace top latitude

Route trace top northing

Route trace type

Run time

Samples

Scan data AFD Griffin

Scan data LCR Griffin

Scan data Max Griffin

Scan data mean Griffin

Scan data min Griffin

Scan data single Griffin

Speed

Spheroid flattening

Spheroid semi-major axis

Spheroid semi-minor axis

Start time

Title

Top latitude

Top northing

Total datum

Total distance

Total tooms

Total waypoints

Table 4 Description of all fields
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Transport used

UTM

Version

Waypoint

Waypoint bottom Y

Waypoint count

Waypoint left X

Waypoint notes

Waypoint ordinal

Waypoint right X

Waypoint suspect ID

Waypoint top Y

Waypoint type

Waypoint X

Waypoint Y

Table 4 Description of all fields
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Chapter 8 Maintenance and Troubleshooting

This chapter describes how to identify and correct problems related to the Hind-
site. Topics discussed in this chapter are as follows:

– “Troubleshooting” on page 100

– “Solving problems” on page 100
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Troubleshooting
Some typical problems that may arise when using Hindsite are listed below, 
together with solutions. If you are unable to resolve problems related to the 
Hindsite, refer to “Technical assistance” on page xiv.

Solving problems
If you experience difficulties using the Hindsite, refer to the related topic. Each 
topic describes problems and solutions that may be pertinent to your task. If you 
are unable to resolve your problem, please contact “Technical assistance” on 
page xiv.

Installing software

Problem Hindsite does not start properly after software installation. What’s wrong with 
it?

Solution The files dwreg32.ocx and dwstg32.ocx sometimes do not self-register with 
Windows. A reinstallation sometimes works, otherwise you will have to register 
the files manually by the following procedure:

1 On the Windows task bar, select Start > Command.

2 Enter the following text:
regsvr32 c:\windows\system\dwreg32.ocx

3 Repeat the first two steps with the following text: 
regsvr32 c:\windows\system\dwstg32.ocx

Licensing

Problem Why can I not get Hindsite to accept the license codes that I received from 
Willtek?

Solution In rare cases, the file scrrun.dll did not register with Windows. You can make up 
for this by following the procedure below:

1 On the Windows task bar, select Start > Command.

2 Enter the following text:
regsvr32 c:\windows\system\scrrun.dll



Chapter 8 Maintenance and Troubleshooting
Solving problems

Willtek 8010 HindsiteTM RF Propagation Test Software Version 2.20 101

Confidence level
exceeding 100%

Problem Hindsite delivers confidence values of more than 100%. How can this be?

Solution This is due to Windows booting up while the GPR is switched on and attached to 
the serial port. The following steps resolve the problem:

1 Reset the GPR and switch it off and on.

2 Restart the measurements.

Wheel calibration

Problem Why do I receive error messages when calibrating the wheel transducer?

Solution This may happen in conjunction with the Griffin when the communications port 
is not yet set up properly.

1 Set up the communications port for the Griffin; see “Communications 
settings” on page 15 and “Griffin Communications Settings” on page 58.

2 Restart the wheel calibration.

Keyboard markers

Problem Hindsite added multiple keyboard markers when I tried to define a single one. 
What went wrong?

Solution This happens when the key is depressed too long. The sensitivity of the keys can 
be changed in the Windows settings.

Local coordinates

Problem The local coordinates option is disabled; how can change the coordinate system 
now?

Solution Please ensure that the name of the first .TAB file in the map folder does not end 
with a digit.
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Problem How can I avoid getting error messages when I change local coordinates?

Solution An error message appears when you try changing local coordinates while config-
uring Hindsite. Change the coordinates during a measurement run only.

Route tracing

Problem After a route trace has been performed, the views do not reflect the current 
status?

Solution Close all views and reopen them so the modified data can be displayed.

Communications problems If you experience problems communicating with the instruments try checking 
that

– the cables are properly attached at both ends

– every instrument is connected to the correct port as used in the configura-
tion

– the communications settings in Hindsite and in the instruments match

– the power supply to the instruments is reliable

Map problems Most map problems are due to incorrect selection of the folder containing the 
maps, invalid files within the folder or invalid map file formats. Try reinstalling 
the maps into a new folder and setting Hindsite to use the new folder. Ensure 
that the maps are in valid MapInfo format and include the .TAB files.

Performance problems If you are running Hindsite on a PC that does not have sufficient processing 
power or memory you might run into problems where the PC is not able to keep 
up with the amount of work that it has to do. The best solution is to upgrade to 
a more powerful PC. If this is not possible you could try changing your configu-
ration to reduce the amount of work that Hindsite must do. Try:

– removing any unnecessary views

– reducing the number of measurements that must be processed per second

– closing any other applications

– disabling any virus protection software from checking the Hindsite files
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Plotter/printer driver
interactions

Some users have reported problems where plotter or printer drivers installed on 
the PC interfere with Hindsite's use of the parallel port. At this time Willtek is 
still investigating this situation, so cannot offer any particular advice apart from 
to try to remove the driver to test if it is causing a problem. Please report your 
findings to Willtek.

Parallel port problems Some users have reported problems with using the parallel port and found that 
it worked when changed to unidirectional (ECP) mode. Our experience is that it 
works in both bidirectional (EPP) and unidirectional modes. This might be an 
issue that depends on the make of PC being used or its settings.

Diagnosing problems
during a drive test

If you suspect problems during a drive test try adding an events table. This will 
show you if any instrument had a problem during the run, for example, if a navi-
gation instrument lost lock.

Willtek technical support If you are unable to overcome the problems yourself you can contact Willtek 
Technical Assistance Center (see “Technical assistance” on page xiv). An email is 
the most effective way of asking for support. You should include the configura-
tion file, drive test results file and any Hindsite log file that was produced along 
with a complete description of the problem and your PC.

The Hindsite log file is automatically recorded in the Hindsite folder with the 
name 'HindsiteNNNN' and an extension of '.LOG'. NNNN is a number which is 
updated each time Hindsite is started.

Log files which do not contain problem reports are deleted automatically by 
Hindsite, but those which do contain reports are not deleted. You should check 
the Hindsite folder occasionally and delete any redundant log files. Hindsite 
should not be running while you delete the log files.
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Appendix A Applications of the Griffin

This appendix describes how the Griffin can be used with Hindsite. The topics 
discussed in this appendix are as follows:

– “Distance resolution issues” on page 106

– “Time to retune and take measurements” on page 106

– “Sampling and triggering” on page 107

– “Cycling or scanning considerations” on page 108

– “Histogram considerations” on page 109

– “Data buffer issues” on page 109

– “Lee sampling” on page 109

– “Guide to avoiding problems” on page 110
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Distance resolution issues
When making measurements at relatively short distances some issues can arise 
from the resolution of the distance transducer used. This section will explain 
these issues.

A distance transducer produces a pulse every time the vehicle moves through a 
set distance. This distance will depend on the size of the vehicle's wheel and the 
number of pulses per revolution. Typically this distance is about 2 cm when the 
distance transducer has 100 pulses per revolution. You can find out the resolu-
tion of your system by noting the number of pulses recorded during the vehicle 
calibration process and dividing this into the distance you travelled. (Note that 
you should express the distance in cm to get the resolution in cm).

The Griffin receivers count pulses to measure the distance travelled. Since each 
pulse represents a set distance, the resolution of the distance that can be 
measured by the Griffin depends on the distance transducer.

When the Hindsite software calculates the number of pulses to count between 
samples or measurements it will divide the distance required by the distance 
resolution. This can result in a rounding error where the distance required is not 
an integral multiple of the distance resolution. For example, if you ask for 
samples every 5 cm when you have a distance resolution of 2 cm Hindsite will 
calculate the number of pulses as 5 / 2 = 2.5 and will round this up to 3. Thus 
the actual distance between samples will be 3 x 2 cm = 6 cm.

Following this example, if the measurement is to take the mean of 100 samples, 
the actual distance covered will be 6 x 100 = 600 cm, compared to the 
5 x 100 = 500 cm that might be expected from the values entered. If you had 
selected a frequency spacing of 550 cm, the Griffin would be unable to make the 
measurements as it would need to change the frequency before it had completed 
the 100 samples. The solution in this example is to set the frequency spacing to 
greater than 600 cm.

Time to retune and take measurements
When considering measurement times it is important not to forget the retuning 
and autoranging time.

The Griffin takes 1 ms to tune from one frequency to another and to autorange. 
For example, if you ask for a mean measurement of 200 samples taken at 
100 kHz, the time spent making the measurement would be 2 ms, and the time 
spent changing frequency would be 1 ms. The Griffin could cycle around 
10 frequencies in 30 ms.

This 1 ms time is always present, even if the Griffin is working on one frequency, 
since the time is required for autoranging.

The time to take measurements will limit the maximum speed at which you can 
travel for any given settings. For example, suppose that you chose to do a mean 
measurement over 19 ms with a frequency spacing of 0.3 m. The total time 
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needed for each measurement would be 20 ms. If you travel the 0.3 m in less 
than 20 ms the Griffin does not have long enough to complete one measurement 
process before it must start the next. The maximum speed that you could travel 
at is 0.3 m in 20 ms or 15 m/s or 54 km/h.

Sampling and triggering
First we must explain the relationship between triggering and sampling in the 
Griffins. The Griffins do not measure continuously, they must be triggered to start 
a measurement. Once triggered the measurement will be completed and, at the 
end of the measurement, the Griffin will retune to the next frequency. It will then 
wait for a trigger to start the measurement on the new frequency. Thus when 
you set the triggering you are controlling when the Griffin will change frequency 
and this is why it is called the 'frequency spacing' on the Acquisition tab. 

Once a measurement is started by a trigger, the Griffin will gather a number of 
samples to make the measurement. The samples are all equally-spaced in either 
time or distance. So, if you choose 100 samples at a sampling rate of 100 kHz it 
will take 1 ms to gather them. Alternatively, if you choose 100 samples at 12 cm 
spacing it will take 1200 cm to gather them.

Hindsite allows you to control separately the sampling and triggering processes 
in the Griffin. You can use any combination of time and/or distance for them. 
Selecting the appropriate modes depends on the information that you need.

If you choose to use a mixture of time and distance you can run into situations 
where the Griffin cannot complete one measurement before the trigger arrives 
for the next measurement. This can also happen if you drive too fast for the 
particular settings you have chosen. One obvious example is if you chose 
sampling based on distance and triggering based on time. When you stop the 
sampling will stop but triggering will continue. 

Distance vs. time sampling The Griffin allows you to use distance or time to control the instants when it 
samples the RF signal. This is possible because the distance transducer is 
connected directly to the Griffin. Whether to use distance or time for the 
sampling depends on the type of measurement you are doing.

Using distance will give you samples equally-spaced in distance, whatever speed 
you travel at. When you stop no samples will be taken. There are two limitations 
to consider. The first is the resolution of the distance transducer used, which is 
addressed in elsewhere in this appendix. The other is the maximum rate of pulses 
that the Griffin can handle (8 kHz). This limits the maximum speed for a given 
distance transducer.

Distance sampling is more appropriate where you wish to make a measurement 
with samples spread over a given distance. This is similar to Lee, where the 
samples are spread over 40 λ (Hindsite does Lee in a different way).
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Time sampling is more appropriate either where you wish to measure the time 
characteristics of the signal or where you wish to use it as a filter. Time sampling 
has the advantage of allowing more samples to be taken in a given time period 
than is possible with distance sampling.

Measuring the time
characteristics of the signal

If you are interested in the time characteristics of the signal, such as the fade 
statistics measured every 400 ms, you would use time sampling to make the 
measurement. This is often more useful to assess how a human perceives the 
performance of the system as, for example, it puts more weight on an area of low 
signal and low speed.

Filtering the signal You can use the mean measurement mode of the Griffin to act as a filter to give 
a better measurement of the signal. For example, you could take the mean of 
100 samples at 100 kHz (which lasts 1 ms) instead of a single sample. The mean 
would reduce the random noise on the measurement, but of course takes longer 
to measure. You would not be able to travel as fast as when taking a single 
sample. Taking the mean is broadly similar to using a low-pass filter with a band-
width that depends on the period over which you take the mean. Using time 
sampling, the bandwidth of the filter is a constant whatever speed you drive at.

Distance vs. time
triggering

The Griffin allows you to use distance or time to control the instants when it 
starts a measurement of the RF signal. This is called triggering as each measure-
ment is triggered to start. Whether to use distance or time for the triggering 
depends on the type of measurement you are doing.

Using distance will give you measurements equally-spaced in distance, whatever 
speed you travel at. When you stop no new measurement will start. 

Distance triggering is more appropriate where you wish to make measurements 
equally-spaced in distance. This is similar to Lee, where a measurement is started 
every 40 λ (Hindsite does Lee in a different way).

Time triggering is more appropriate either where you wish to measure the time 
characteristics of the signal. 

Cycling or scanning considerations
The thing to remember when cycling or scanning is that the frequency spacing 
parameter will be the same for each frequency. Thus if you decide to cycle round 
8 frequencies with a frequency spacing of 32 cm, any particular frequency will 
be measured every 8 x 32 cm = 256 cm.

To make a measurement on all 8 frequencies in 32 cm you would have to set a 
frequency gap of 4 cm. This might bring in resolution issues as discussed in this 
appendix.
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Histogram considerations
When measuring histograms, the Griffin has a lot of calculation to do and there 
are lots of data to send to the PC. These factors limit the number of histograms 
that can be completed per second to a maximum of 20. You must take care when 
choosing the settings for the histogram that you observe this limit even when 
travelling at your maximum speed. In general, it is a good idea to use as many 
samples as possible for a histogram as that way you will get the most accurate 
statistics.

Data buffer issues
The Griffin has a 16 kilobyte buffer, which it uses to store results on their way to 
the PC. If the measurements being made by the Griffin produce more data than 
can be passed over the data link to the PC then the data buffer will gradually fill 
up. This usually shows itself as a delay between when you stop a drive test and 
the test actually stopping. It is important to ensure that the baud rate you have 
chosen for the data link is adequate to carry the amount of data that your 
measurements will produce. 

Lee sampling
Many people use the Lee sampling criterion or variations on the same theme. 
With Hindsite and the Griffin you can have some flexibility in how you do this 
form of sampling.

Do not confuse the word sampling in 'Lee sampling' and as used by the Griffin 
sampling. They are not always the same.

Averaging in the Griffin If you are working on a single frequency, you can use the following settings:

– Measurement Mode = Mean

– Sampling = Distance

– Number of Samples = y

– Sample Spacing = x

– Triggering = Distance

– Frequency Spacing = x times y + a margin

You must choose y to be the number of samples to average, that is calculate the 
mean, (40 for Lee) and the sample spacing as above. The frequency spacing must 
be great enough to cover a distance of x times y, so it should be set to slightly 
greater, x times (y+1) is generally suitable.

You do not need to use the averaging facility within Hindsite and you cannot 
change the number of samples at a later date.
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Averaging in Hindsite Alternatively you can use the following settings:

– Measurement Mode = Single

– Sampling = Time

– Sample Rate = 100 kHz

– Triggering = Distance

– Frequency Spacing = x

You must calculate x to be the required sample spacing, for example with Lee it 
is about 0.8 λ. You must be careful about resolution issues as this is only 12 cm, 
which could have a significant rounding error.

You must now use the averaging facility within Hindsite to average the required 
number of samples (40 for Lee). You can change the number of samples you 
average over at any later date as all the raw samples will be stored by Hindsite.

This is the preferred way to work if you wish to measure on several frequencies 
at the same time and over the same area. You would need to change x to be the 
distance divided by the number of frequencies. For example to measure on two 
frequencies in the example above you would set a distance of 6 cm.

Guide to avoiding problems
There are some principles that, if you follow, should avoid most of the problems 
in setting the Acquisition tab.

Things to avoid Using distance triggering with time sampling.

Using distance sampling with short distances compared to the resolution of your 
distance transducer.

Using sampling or triggering settings that mean the Griffin is triggered at the 
same instant that the measurement is finished.

Things to do Check the distance transducer resolution and calculate the impact of your 
distance settings.

Plan the measurements that you need thinking both in terms of time and 
distance. Remember to allow for 1 ms for the Griffin to retune between frequen-
cies.

To achieve the maximum number of frequencies per second use single sampling 
as it is much faster than mean.
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Appendix B Antenna Factor Files

This appendix describes the syntax for antenna factor files, which can be used to 
compensate the frequency-dependent antenna loss or gain. 
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You can convert your measurements from signal strength in dBm or dBµV to field 
strength in dBm/m or dBµV/m. To do so you must prepare a file containing the 
antenna factors for your antenna as a function of frequency. The file must be in 
a folder called 'Antenna' located in the Hindsite folder. You should give each file 
a name that allows you to identify the antenna. The extension of the file is not 
used by Hindsite so can be anything you wish.

The format of the file is as follows:

Frequency(Hz)   [Tab]  Antenna Factor(dB)

Frequency(Hz)   [Tab]  Antenna Factor(dB)

Frequency(Hz)   [Tab]  Antenna Factor(dB)

For example, 

1700000000 +10.5

1950000000 +11.5

2000000000 +12.7

The frequencies must be in ascending order and there must not be a blank line 
at the start of the file. 

You can put just one frequency in the file and then its antenna factor will be used 
at all frequencies.

You can use as many lines as you wish but, unless the antenna varies very quickly 
over frequency, one every 10 or 20 MHz will probably be sufficient. When the 
measurement frequency lies between two of the frequencies in the file Hindsite 
uses linear interpolation between the factors to calculate the factor for the 
measurement frequency. If the antenna factor of the antenna does not vary 
much between the two points then linear interpolation will give an accurate 
result. If it does vary much, then you should add more points to retain the accu-
racy.

If the measurement frequency is above the maximum frequency in the file, then 
the antenna factor for the maximum frequency is used. (Hindsite does not 
extrapolate the antenna factors). Conversely, if the measurement frequency is 
below the minimum frequency in the file, then the antenna factor for the 
minimum frequency is used. 

If the file is not in the expected format, then no antenna factor is applied. Willtek 
recommends that you check that the factors are being applied properly before 
making measurements using the antenna factors file.

The antenna factor is added to the reading from the instrument. This has the 
effect of changing the units of the reading from dB to dB/m, so for example, 
readings in dBm would be changed to dBm/m.

The antenna factor can either use a comma or a stop as the decimal point char-
acter.



C

Willtek 8010 HindsiteTM RF Propagation Test Software Version 2.20 113

Appendix C Converting FSS Run Files

This appendix describes how FSS run files can be converted to Hindsite drive test 
result files.
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Run files produced by Willtek's Field Surveying Software (FSS) can be converted 
to Hindsite drive test result files. These must be FSS version 8 files.

Within Hindsite, select the File > Import FSS File… menu . Select, from the 
dialog, the file you wish to convert, click OK and then choose, in the subsequent 
dialog, a name to be given to the converted file.

Click OK again and the file will be converted. The converted file may then be 
treated as any other drive test results file except that, due to some missing infor-
mation, the file cannot be replayed by Hindsite.
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Appendix D Options and Hardware Configurations

This appendix describes useful options and the various supported hardware 
configurations of Hindsite. Topics include:

– “Introduction” on page 116

– “Options” on page 116

– “Hardware configurations” on page 122
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Introduction
There are many different hardware configurations for Hindsite covered in this 
appendix. These are supplied by Willtek as combinations of options. You can 
choose which configuration best suits your measurement needs and then order 
the required options to complete that configuration. The first section of this 
appendix describes the options and the second section describes how to 
assemble the systems. 

Options

Wheel kits A wheel kit consists of a distance transducer and the parts necessary to fix it to 
the wheel of a vehicle. The distance transducer mounts onto a wheel plate. The 
wheel plate mounts onto a set of clamping sockets which clamp onto the wheel 
nuts which hold the wheel onto the vehicle. Each wheel plate has slots in it to 
suit wheel nuts at different radii.

Willtek can supply wheel plates to suit vehicles with four, five or six wheel nuts, 
and clamping sockets to fit the majority of standard wheel nuts.

The standard wheel kits fit most common sizes of wheel used on motor cars. 
Alternative sizes of socket and wheel plate are available on request as follows:

Carefully read the assembly instructions and the “Safety notes” on page ii before 
using a wheel kit.

WHK1 The standard wheel kit (WHK1) supplied for use with the GPR options consists of:

Table 5

Item Description

WHC22 Set of five 22 mm AF clamping sockets

WHC22 Set of five 26 mm AF clamping sockets

WHC26 Set of five 27 mm AF clamping sockets

WHC27 Five-slot wheel plate, large, 75-97R

WHP5L Six-slot wheel plate, 49-89R

Table 6

Item Description

WHT2A Distance transducer (100 pulses per revolution)

WHC17 Set of five 17 mm AF clamping sockets

WHC19 Set of five 19 mm AF clamping sockets
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WHK5 The standard wheel kit (WHK5) supplied for use with the Griffin options consists 
of:

GPR Distance Option This option adds distance input to Hindsite when used with a GPR series receiver. 
It allows you to make measurements spaced accurately apart in distance. When 
combined with option HST-GPS455/GPR, it also allows you to improve the accu-
racy of your navigation with dead reckoning.

This option comprises:

To complete the system you will also need a GPR series receiver.

WHC21 Set of five 21 mm AF clamping sockets

WHP4 Four-slot wheel plate, 46-74R

WHP5S Five-slot wheel plate, small, 46-74R

Table 6

Item Description

Table 7

Item Description

WHT5 Distance transducer (500 pulses per revolution)

WHC17 Set of five 17 mm AF clamping sockets

WHC19 Set of five 19 mm AF clamping sockets

WHC21 Set of five 21 mm AF clamping sockets

WHP4 Four-slot wheel plate, 46-74R

WHP5S Five-slot wheel plate, small, 46-74R

Table 8

Item Description

WHK1 Wheel kit, containing a distance transducer (WHT2A) 
and wheel mounting plates.

PPA9306 Interface box

IL2713 Vehicle power lead for the GPR 

IL2937 Serial data lead for the GPR 

IL5300 PPA power-in and pulses-out cable

IL8317 Four-way power distribution cable
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HST-PPA/GPR This option (available on request only) adds distance input to Hindsite when used 
with a GPR series receiver. This option is only suitable for use when upgrading 
an earlier FSS system where you already have a WK1 wheel kit, IL2713 cable and 
IL2937 cable.

This option comprises:

To complete the system you will also need:

With this system you can also use a JRC JLR3310 (Willtek option HST-GPS3310), 
Trimble Placer 455 (Willtek option HST-GPS455/GPR) or NMEA-compatible navi-
gation receiver for which you would need suitable leads. 

SMR Distance Option This option adds distance input to Hindsite when used with an SMR (Griffin) 
series receiver. It allows you to make measurements spaced accurately apart in 
distance. When combined with option HST-GPS455/SMR, it also allows you to 
improve the accuracy of your navigation with dead reckoning.

This option comprises:

To complete the system you will also need:

Table 9

Item Description

PPA9306 Interface box

IL5300 PPA power-in and pulses-out cable

IL8317 Four-way power distribution cable

Table 10

Item Description

WHK1 (or alter-
native)

Wheel kit, containing a distance transducer (WHT2A) 
and wheel mounting plates.

GPR series 
receiver

IL2713 Vehicle power lead for the GPR 

IL2937 Serial data lead for the GPR 

Table 11

Item Description

WHK5 Wheel kit, containing a distance transducer (WHT5) and 
wheel mounting plates.

IL8317 Four-way power distribution cable
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With this system you can also use a JRC JLR3310 (option HST-GPS3310), Trimble 
Placer 455 (option HST-GPS455/SMR) or NMEA-compatible navigation receiver 
for which you would need suitable leads. 

Trimble 455 GPS Option This option adds the Trimble Placer 455 GPS navigation receiver to Hindsite when 
used with a GPR receiver. To use the Placer 455 in dead reckoning mode you must 
have option GPR Distance Option as well.

This option comprises:

To complete the system for use with a GPR receiver you will also need:

Table 12

Item Description

Griffin series 
receiver

IL8119 Vehicle power lead for the Griffin (supplied with the 
Griffin)

G994203 Serial data lead for the Griffin (supplied with the 
Griffin)

Table 13

Item Description

Placer 455 
receiver

MagMount 
Antenna

Complete with lead

Heading sensor 

Trimble manual

Trimble 30511 T-lead from Placer to MDT and RTCM connectors.

IL5544/1 RS-232 cable

IL5545 Modified Trimble interconnection lead 30513

IL5599 Power lead for Placer modified from Trimble lead 30514

Table 14

Item Description

HST-DT/GPR Hindsite distance option for the GPR

GPR series 
receiver
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HST-GPS455/SMR This option, available on special request only, adds the Trimble Placer 455 GPS 
navigation receiver to Hindsite when used with a Griffin receiver. To use the 
Placer 455 in dead reckoning mode you must have option HST-DT/SMR as well.

This option comprises:

To complete the system for use with an SMR (Griffin) receiver you will also need:

JRC GPS Option This option is no longer available as the JLR3310 is obsolete. This section is 
retained for people who already have a JLR3310 and would like to use it with 
Hindsite.

You can use the receiver with either a GPR series or an SMR (Griffin) series 
receiver. You can use it with either option HST-DT/SMR or HST-DT/GPR to get 
distance inputs as well.

This option used to comprise of:

Table 15

Item Description

Placer 455 
receiver

MagMount 
Antenna

Complete with lead

Heading sensor 

Trimble manual

Trimble 30511 T-lead from Placer to MDT and RTCM connectors.

IL5544/1 RS-232 cable

IL8312 Modified Trimble interconnection lead 30513

IL5599 Power lead for Placer modified from Trimble lead 30514

Table 16

Item Description

HST-DT/SMR Hindsite distance option for the SMR

Griffin series 
receiver

IL8119 Vehicle power lead for the Griffin (supplied with the 
Griffin)

G994203 Serial data lead for the Griffin (supplied with the 
Griffin)
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Those items marked with a * are still available from Willtek as accessories.

HST-GPS35PC This option, available on special request only, adds the Garmin GPS35PC GPS 
navigation receiver to Hindsite. You can use this option with either a GPR series 
or Griffin series receiver. You can use it with either option HST-DT/SMR or HST-
DT/GPR to get distance inputs as well.

This option comprises:

HST-PEDO/GPR This option, available on special request only, adds the Willtek Pedometer to 
Hindsite when used with a GPR receiver. 

This option comprises:

Table 17

Item Description

JLR3310 Part of Willtek part no. 790603

MagMount 
Antenna

Part of Willtek part no. 790603

JLR3310 manual Part of Willtek part no. 790603

Floppy disk with 
JRC software

Part of Willtek part no. 790603

IL2713* Vehicle power lead for the GPR 

IL2937* Serial data lead for the GPR 

IL4731 Modified JRC lead with RS-232 data and RTCM connec-
tors. 

IL8317* Four-way power distribution cable

Velcro strip To be used to mount the receiver

Table 18

Item Description

GPS35PC Part of Willtek part no. 790606

MagMount Willtek part no. 790607

GPS35PC man-
ual

Part of Willtek part no. 790606

IL2713 Vehicle power lead for the GPR

IL2937 Serial data lead for the GPR

IL8317 Four-way power distribution cable
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Hardware configurations

Vehicle power All of the Hindsite systems can be powered from a vehicle 12 V supply. To provide 
a convenient way of connecting several pieces of equipment to the vehicle's 
supply, Willtek provides a lead, IL8317, which plugs into the cigar lighter socket 
of a vehicle and has four cigar lighter sockets as outlets. 

Although there seem to be few problems reported, the cigar lighter socket was 
not designed to be a reliable connector for electronic equipment. Therefore, to 
ensure maximum reliability, Willtek recommends that a well-engineered and 
fused supply is built into the vehicle and used to power the Hindsite system.

Willtek recommends that you start the vehicle before turning the Hindsite 
system on. This avoids any problems due to large voltage drops during starting.

Powering the PC To power the PC from the vehicle supply usually needs an adapter. Some adapters 
can be connected to the vehicle supply, others need an inverter to convert the 
12 V DC to 120 or 240 V AC. Where Willtek supplies the PC Willtek can also 
supply the necessary adapters. In other cases, please refer to the PC supplier or 
manufacturer for advice and suitable adapters.

System differences Each of the Hindsite hardware configurations has differences from the others. 
This section addresses the main differences that apply to many of the systems.

Systems with distance
measuring ability

Systems with distance input allow you to specify the spacing of your measure-
ments in terms of distance or time. Additionally, the system with the Griffin 
receiver allows you to specify the sample spacing in terms of distance.

When using distance input with the GPR series of receivers the system includes 
a PPA9306 interface box to condition the pulses from the distance transducer 
before they are input to the PC. The PC counts the pulses and triggers a measure-
ment in the GPR at the appropriate time. 

Table 19

Item Description

PPA9306 Interface box

IL4885 Pedometer 

IL4861 Combined serial and parallel data lead from the PPA to 
the computer

IL4862 Data lead from the PPA to the GPR

IL4890 Computer carrying tray with straps
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When using distance input with the Griffin series of receivers the system does 
not need a PPA9306 as the pulse conditioning and counting is done inside the 
Griffin.

Systems without distance
measuring ability

Without distance measuring ability you are only able to specify the spacing of 
your measurements in terms of time. The only differences between the systems 
that use the GPR or Griffin are the power and data leads for the receivers. These 
leads are supplied with the receivers rather than with any of the Hindsite 
options.

Systems with JRC JLR3310
GPS receiver

There are four variants of Hindsite system using the JRC JLR3310 navigation 
receiver, two for the GPR series of measuring receivers and two for the SMR 
(Griffin) series of measuring receivers. With each measuring receiver, there is a 
system with, and a system without distance measuring ability.

The navigation receiver is supplied with a lead, IL4731, which connects power to 
the receiver and data to the serial port of the PC. 

The JLR3310 is able to accept differential corrections via a connector on lead 
IL4731. Willtek does not supply the leads or data receiver for differential correc-
tions as these vary from country to country. Please refer to the JLR3310 manual 
for information about connecting a differential receiver.

The following table lists the Hindsite options required to complete these systems. 

Connect your chosen system as shown in the following figures.

For a GPR system without distance omit the WHT2A, PPA9306 and IL5300 items.

For a Griffin system without distance omit the WHT5.

Table 20

System Options Required

GPR with distance JRC GPS Option and 
GPR Distance Option

GPR without distance JRC GPS Option

Griffin with distance JRC GPS Option and
HST GPR Distance Option

Griffin without distance JRC GPS Option

Note

The JRC GPS Option is no longer available.



Appendix D Options and Hardware Configurations
Hardware configurations

124 Willtek 8010 HindsiteTM RF Propagation Test Software Version 2.20



Appendix D Options and Hardware Configurations
Hardware configurations

Willtek 8010 HindsiteTM RF Propagation Test Software Version 2.20 125

Systems with NMEA
compatible navigation

receivers

There are four variants of Hindsite system using an NMEA compatible navigation 
receiver, two for the GPR series of measuring receivers and two for the SMR 
(Griffin) series of measuring receivers. With each measuring receiver, there is a 
system with, and a system without distance measuring ability.

Willtek does not supply any NMEA compatible navigation receivers, but does 
supply a serial data lead, IL4860, which can be used to connect the receiver to 
the PC.

The following table lists the Hindsite options required to complete these systems. 

Connect your chosen system as shown in the following figures.

For a GPR system without distance omit the WHT2A, PPA9306 and IL5300 items.

For a Griffin system without distance omit the WHT5.

Table 21

System Options required

GPR with distance GPR Distance Option

GPR without distance IL5535 (multiway power lead)

Griffin with distance SMR Distance Option

Griffin without distance IL5535 (multiway power lead)
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Systems with JRC
GPS35PC GPS receiver

There are four variants of Hindsite system using the Garmin GPS35PC navigation 
receiver, two for the GPR series of measuring receivers and two for the SMR 
(Griffin) series of measuring receivers. With each measuring receiver, there is a 
system with, and a system without distance measuring ability.

The following table lists the Hindsite options required to complete these systems. 

Connect your chosen system as shown in the following figures.

For a GPR system without distance omit the WHT2A, PPA9306 and IL5300 items.

For a Griffin system without distance omit the WHT5.

Table 22

System Options required

GPR with distance HST-GPS33PC and 
GPR Distance Option

GPR without distance HST-GPS35PC

Griffin with distance HST-GPS35PC and
SMR Distance Option

Griffin without distance HST-GPS35PC
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Systems with Trimble
Placer 455 GPS receiver

There are two variants of Hindsite system using the Trimble Placer 455 naviga-
tion receiver, one for the GPR series of measuring receivers and one for the SMR 
(Griffin) series of measuring receivers. Both systems have distance measuring 
ability.

The system for use with an GPR series of receivers includes the PPA9306 inter-
face box. The system for use with an SMR (Griffin) series of receiver does not 
need the PPA9306.

The following table lists the Hindsite options required to complete these systems. 

Table 23

System Options required

GPR Trimble 455 GPR Option and 
GPR Distance Option

Griffin HST-GPS455/SMR and
SMR Distance Option
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Columbus 2000 System The Columbus 2000 system, also know as FSS 888, was originally supplied to 
work with the FSS software. It packages a Trimble Placer 455, PPA9306 and 
interconnecting cables into one box that also houses a GPR receiver. The 
Columbus 2000 will work unmodified with the Hindsite software. It is only suit-
able for use with a GPR series receiver.
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Pedometer system The pedometer system is designed for surveys in shopping malls and similar 
places. At present this is not suitable for use with the Griffin series of receivers. 
The PPA9306 can be housed in the converter portion of a GPR+converter leather 
case.

Adapting older systems If you have a distance transducer and wheel kit that you would like to use with 
a new Griffin receiver, then you will need adapter leads. There are two leads 
available with suitable connectors at each end.

PPA9306

PC

IL4861

GPR
IL4862

IL4885
Pedometer

POWER
INPUT

COMPUTER

DISTANCE
TRANSDUCER

ParallelSerial Port

Tray
IL4890

System with Pedometer and GPR

Table 24

Adapter Function

IL8120 Distance transducer (WHT2A) to Griffin Pulse Enc. input.

IL8275 Modified Trimble 455 cable to Griffin Pulse Enc. input.
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Appendix E Fitting the Wheel Transducer

This appendix describes how to set up the wheel transducer.
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Follow the steps below to install the wheel transducer:

1 Fit clamping sockets to the wheel plate on the opposite side from the studs. 
This is achieved by holding a clamping socket in one hand and carefully 
removing the screw along with both large and small washers. Pass the screw 
through the wheel plate and screw it back into the clamping socket. Both 
washers should be under the head of the screw. Do not tighten at this stage. 
Repeat for each clamping socket.

2 Fit above assembly onto one of the vehicle's rear wheels, ensuring all of the 
clamping sockets fit right down over the wheel nuts.

3 Fit the circular plate on the wheel transducer to the studs of the wheel plate 
and tighten fully.

4 Fit the 'G' clamp to a convenient position on the wheel arch and lead the 
cable into the vehicle.

5 Ensure that all screws are tight and that the assembly is secure before each 
run.

6 Read the safety warnings at the beginning of this manual before using a 
vehicle with the wheel transducer fitted.
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Appendix F Changes from Earlier Releases

This appendix contains the change history of Hindsite.



Appendix F Changes from Earlier Releases
Introduction

136 Willtek 8010 HindsiteTM RF Propagation Test Software Version 2.20

Introduction
Willtek has a programme for continuous improvement of Hindsite, adapting it to 
meet evolving measurement needs and requests from customers. As a result of 
this programme, each release of Hindsite incorporates changed features. This 
appendix outlines the most significant changes made to the Hindsite system in 
recent releases; it does not list every change. 

Release 2.20, June 2004

New features Decimal degrees added to the coordinate system choice.

Time-triggered route tracing now available.

Map legends can now be saved and loaded (range and color presentations).

Signia format export facility used by Aircom Asset tool.

Upgrade of Run Data Notes.

Composite coverage map and table added.

The ability to add distance to time-triggered runs based on GPS coordinates. 
Accurate to within 10%.

In multiple frequency runs, the ability to remove a frequency from either the Best 
Server or Composite Coverage map views.

Selectable COM ports now up to 12.

Level Detect on GPR now automatically set to 5 ms.

New demo files added.

New fields added; Best Signal, Best Frequency, GPS Distance.

Problems resolved Route trace button disabled during configuration and run.

Shortcut key for close is now Ctrl-F4.

Spectrum analyzer tab for Willtek 8300 Griffin disabled.

Fixed error 2006 which related to database for menu items and icons.
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Release 2.10, March 2003

Changes made Willtek 8382 Up-Converter has been added to the converter list.

Compatibility Hindsite is fully compatible with Windows 2000 and Windows XP now.

Release 2.00, July 2002

Changes made A new, general-purpose marker replaces the markers from previous versions 
(position marker, suspect point marker, suspect region marker).

In-building plans can be imported now.

Outdoor and in-building route tracing allow mapping of results to routes.

Changing the coordinate system between WGS-84 and local coordinates is 
supported now.

Reliability The reliability of Hindsite has been improved in many ways.

Compatibility There are no compatibility issues.
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Release 1.30, July 2001

Changes made

GPR Down Converter added Allowance is now made for a 8181 GPR Down Converter (1700 to 2500 MHz) 
(formerly GFC 4950) being attached to a 8301 Griffin Fast Measurement 
Receiver (formerly SMR 9010).

Garmin GPS35PC hardware
option added

This GPS navigation receiver is now available as a Hindsite option.

JRC GPS3310 option obsolete This GPS receiver is now obsolete so it is no longer offered as an option with 
Hindsite. (Existing receivers will continue to be supported until July 2002.)

Reliability Various changes have been made to improve the reliability of Hindsite.

Compatibility The configuration and result files have not been changed so there should be no 
compatibility issues.

Release 1.20, December 2000

Changes made

Performance Various changes have been made to improve the performance and reliability of 
Hindsite. These are, in general, not obvious to the user but impact on most areas.

Options Some of the hardware options have been changed as a result of a decision by 
Willtek to handle them in a different way. This has resulted in two versions of 
most options, one dedicated to the GPR and the other to the Griffin receiver. The 
pedometer options are new.

Licence The licensing system has been simplified and changed to offer three versions of 
Hindsite - Demo, Viewer and Full.

Installation Installation on NT4 is now automatic so there is no longer a need for a patch.
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Compatibility The configuration and result files have not been changed so there should be no 
compatibility issues.

The changes to the hardware options have created the potential for incompatible 
connectors but suitable adapter leads are available from Willtek. (See section 
“Options” on page 116).
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Appendix G Warranty and Repair

This chapter describes the customer services available through Willtek. Topics 
discussed in this chapter include the following:

– “Warranty information” on page 142

– “Equipment return instructions” on page 143
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Warranty information
Willtek warrants that all of its products conform to Willtek's published specifi-
cations and are free from defects in materials and workmanship for a period of 
one year from the date of delivery to the original buyer, when used under normal 
operating conditions and within the service conditions for which they were 
designed. This warranty is not transferable and does not apply to used or demon-
stration products.

In case of a warranty claim, Willtek's obligation shall be limited to repairing, or 
at its option, replacing without charge, any assembly or component (except 
batteries) which in Willtek’s sole opinion proves to be defective within the scope 
of the warranty. In the event Willtek is not able to modify, repair or replace 
nonconforming defective parts or components to a condition as warranted 
within a reasonable time after receipt thereof, the buyer shall receive credit in 
the amount of the original invoiced price of the product.

It is the buyer's responsibility to notify Willtek in writing of the defect or noncon-
formity within the warranty period and to return the affected product to 
Willtek’s factory, designated service provider, or authorized service center within 
thirty (30) days after discovery of such defect or nonconformity. The buyer shall 
prepay shipping charges and insurance for products returned to Willtek or its 
designated service provider for warranty service. Willtek or its designated service 
provider shall pay costs for return of products to the buyer.

Willtek’s obligation and the customer’s sole remedy under this hardware 
warranty is limited to the repair or replacement, at Willtek’s option, of the defec-
tive product. Willtek shall have no obligation to remedy any such defect if it can 
be shown: (a) that the product was altered, repaired, or reworked by any party 
other than Willtek without Willtek’s written consent; (b) that such defects were 
the result of customer’s improper storage, mishandling, abuse, or misuse of the 
product; (c) that such defects were the result of customer’s use of the product in 
conjunction with equipment electronically or mechanically incompatible or of an 
inferior quality; or (d) that the defect was the result of damage by fire, explosion, 
power failure, or any act of nature.

The warranty described above is the buyer’s sole and exclusive remedy and no 
other warranty, whether written or oral, expressed or implied by statute or course 
of dealing shall apply. Willtek specifically disclaims the implied warranties of 
merchantability and fitness for a particular purpose. No statement, representa-
tion, agreement, or understanding, oral or written, made by an agent, distributor, 
or employee of Willtek, which is not contained in the foregoing warranty will be 
binding upon Willtek, unless made in writing and executed by an authorized 
representative of Willtek. Under no circumstances shall Willtek be liable for any 
direct, indirect, special, incidental, or consequential damages, expenses, or 
losses, including loss of profits, based on contract, tort, or any other legal theory.
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Equipment return instructions
Please contact your local service center for Willtek products via telephone or web 
site for return or reference authorization to accompany your equipment. For each 
piece of equipment returned for repair, attach a tag that includes the following 
information:

– Owner’s name, address, and telephone number.

– Serial number, product type, and model.

– Warranty status. (If you are unsure of the warranty status of your instru-
ment, include a copy of the invoice or delivery note.)

– Detailed description of the problem or service requested.

– Name and telephone number of the person to contact regarding questions 
about the repair.

– Return authorization (RA) number or reference number.

If possible, return the equipment using the original shipping container and mate-
rial. Additional Willtek shipping containers are available from Willtek on request. 
If the original container is not available, the unit should be carefully packed so 
that it will not be damaged in transit. Willtek is not liable for any damage that 
may occur during shipping. The customer should clearly mark the Willtek-issued 
RA or reference number on the outside of the package and ship it prepaid and 
insured to Willtek.
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Appendix H End-User License Agreement

This appendix describes the conditions for using the software.
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All copyrights in and to the software product are owned by Willtek Communica-
tions or its licensors. The software is protected by copyright laws and interna-
tional copyright treaties, as well as other intellectual property laws and treaties.

This end-user license agreement grants you the right to use the software 
contained in this product subject to the following restrictions. You may not:

(i) use the software and/or any copy of the software in different computers 
concurrently, unless the software is an update that has been downloaded 
from the Internet at www.willtek.com;

(ii) copy the software, except for archive purposes consistent with your stan-
dard archive procedures;

(iii) transfer the software to a third party apart from the entire product;

(iv) modify, decompile, disassemble, reverse engineer or otherwise attempt 
to derive the source code of the software;

(v) export the software in contravention of applicable export laws and regu-
lations of the country of purchase;

(vi) use the software other than in connection with operation of the product.

The licensor's suppliers do not make or pass on to end users or any other third 
party, any express, implied or statutory warranty or representation on behalf of 
such suppliers, including but not limited to the implied warranties of nonin-
fringement, title, merchantability or fitness for a particular purpose.

Willtek Communications shall not be held liable for any damages suffered or 
incurred by you or any other third party (including, but not limited to, general, 
special, consequential or incidental damages including damages for loss of busi-
ness profits, business interruption, loss of business information and the like), 
arising out of or in connection with the delivery, use or performance of the soft-
ware.
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Revision Comment

0207-200-A New general-purpose marker.
In-building plans can be imported.
Outdoor and in-building route tracing for mapping.
Coordinate system change between WGS-84 and local coor-
dinates supported.

0303-210-A 8382 Griffin Up-Converter supported now. Hindsite is fully 
compatible with Windows 2000 and Windows XP.

0406-220-A New features: Composite coverage map and table; time-trig-
gered route tracing; Signia format; decimal degrees coordi-
nate system. Extended map view editor.
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